TREND MICRO
Mobile Security
Service Pack 3
Installation and Deployment Guide
Comprehensive security for enterprise handhelds
Trend Micro Incorporated reserves the right to make changes to this document and to the products described herein without notice. Before installing and using the product, please review the readme files, release notes, and the latest version of the applicable user documentation, which are available from the Trend Micro website at:

http://docs.trendmicro.com

Trend Micro, the Trend Micro t-ball logo, OfficeScan, and TrendLabs are trademarks or registered trademarks of Trend Micro Incorporated. All other product or company names may be trademarks or registered trademarks of their owners.

Copyright © 2020. Trend Micro Incorporated. All rights reserved.

Document Part No. TSEM98901/191217

Release Date: January 2020
The user documentation for Trend Micro™ Mobile Security for Enterprise introduces the main features of the product and provides installation instructions for your production environment. Read through the documentation before installing or using the product.

Detailed information about how to use specific features within the product is available in the Online Help and the Knowledge Base at the Trend Micro website.

Trend Micro always seeks to improve its documentation. If you have questions, comments, or suggestions about this or any Trend Micro document, please contact us at docs@trendmicro.com.

Please evaluate this documentation on the following site:

http://www.trendmicro.com/download/documentation/rating.asp
Privacy and Personal Data Collection Disclosure

Certain features available in Trend Micro products collect and send feedback regarding product usage and detection information to Trend Micro. Some of this data is considered personal in certain jurisdictions and under certain regulations. If you do not want Trend Micro to collect personal data, you must ensure that you disable the related features.

The following link outlines the types of data that Trend Micro Mobile Security for Enterprise collects and provides detailed instructions on how to disable the specific features that feedback the information.


Data collected by Trend Micro is subject to the conditions stated in the Trend Micro Privacy Policy:

Table of Contents

Preface

Preface .................................................................................................................. v
Audience ............................................................................................................. vi
Mobile Security Documentation ....................................................................... vi
Document Conventions .................................................................................. vii

Chapter 1: Planning Server Installation

Architecture of Mobile Security System ...................................................... 1-2
   Enhanced Security Model (Dual Server Installation) with Cloud
   Communication Server ............................................................................... 1-3
   Enhanced Security Model (Dual Server Installation) with Local
   Communication Server ............................................................................... 1-4
   Basic Security Model (Single Server Installation) ............................... 1-5
Components of Mobile Security System ..................................................... 1-5
Comparison Between Local and Cloud Communication Servers .......... 1-9
System Requirements ..................................................................................... 1-9
Summary of Installation .............................................................................. 1-12

Chapter 2: Setting Up Environment

Setting Up Environment for Mobile Security Installation ....................... 2-2
Setting Up Environment for iOS Mobile Devices (Optional) ............... 2-3
Installing Microsoft IIS Web Server ............................................................ 2-6
Installing SQL Server (Optional) ................................................................. 2-7
Setting Up Active Directory Account Access Rights (Optional) ........... 2-8
Installing Microsoft Exchange Server Management Tools (Optional) ... 2-9
Applying Network Access Rules for Mobile Security .............................. 2-9
Chapter 3: Installing, Updating and Removing Server Components

Installing Server Components ................................................................. 3-3
  Before You Install .................................................................................. 3-3
  Installation Workflow for Trend Micro Mobile Security .................. 3-3
  Installing Management Server ............................................................ 3-4
  Installing Local Communication Server ........................................... 3-13
  SMS Sender .......................................................................................... 3-15
  Setting Up Exchange Server Integration ........................................... 3-16

Updating Components ................................................................................ 3-22
  About Mobile Security Upgrade ........................................................ 3-22
  About Component Updates ................................................................ 3-23
  Updating Mobile Security Components ........................................... 3-23
  Manually Updating a local AU server ................................................ 3-26

Removing Server Components ................................................................ 3-27

Chapter 4: Configuring Server Component

Initial Server Setup ....................................................................................... 4-3
  Configuring Database Settings ............................................................. 4-5
  Configuring Communication Server Settings .................................... 4-6
  Configuring Deployment Settings ...................................................... 4-11
  Configuring Device Enrollment Settings .......................................... 4-12
  Customizing Mobile Security Terms of Use ..................................... 4-14
  Configuring Active Directory (AD) Settings ..................................... 4-15
  Configuring Management Server Settings ........................................ 4-16
  Configuring Exchange Server Integration Settings ......................... 4-17
  Configuring Notifications & Reports Settings ................................... 4-19
  Configuring Administrator Notifications ......................................... 4-20

Verifying Mobile Security Configuration .................................................. 4-20

Chapter 5: Handling Mobile Device Agent

Supported Mobile Devices and Platforms ............................................... 5-2
  Device Storage and Memory ................................................................. 5-2

Setting Up Mobile Device Agent ............................................................. 5-3
  Configuring Server for Invitation Messages (Optional) .................. 5-4
Appendix A: Network Ports Configurations

Network Ports Configuration for Basic Security Model ......................... A-9

Appendix B: Optional Configurations

Using Windows Authentication for SQL Server ........................................ B-2
Configuring Communication Server Ports ............................................. B-4
Setting Up SCEP ....................................................................................... B-5
Configuring Local Communication Server High Availability ............... B-8
Example for Local Communication Server High Availability
Configuring ........................................................................................... B-10

Appendix C: Generating and Configuring APNs Certificate

Understanding APNs Certificate ............................................................... C-2
Generating an APNs Certificate .............................................................. C-2
Generating an APNs Certificate from a Windows Server ............... C-4
Generating an APNs Certificate from a Mac Workstation .......... C-18
Uploading APNs Certificate to Mobile Security Management Server C-23
Renewing an APNs Certificate ................................................................. C-25

Index

Index .......................................................................................................... IN-1
Preface

Welcome to the Trend Micro™ Mobile Security for Enterprise 9.8 SP3 Installation and Deployment Guide. This guide assists administrators in deploying and managing Trend Micro™ Mobile Security for Enterprise 9.8 SP3. This guide describes various Mobile Security components and the different mobile device agent deployment methods.


---

**Note**

This Installation and Deployment Guide applies only to Mobile Security version 9.8 SP3. It does not apply to other versions of Mobile Security. Trend Micro support is limited to the use of Mobile Security. To obtain support for third-party applications mentioned in this guide, contact their corresponding vendors.

---

This preface discusses the following topics:

- *Audience on page vi*
- *Mobile Security Documentation on page vi*
- *Document Conventions on page vii*
Audience

The Mobile Security documentation is intended for both administrators—who are responsible for administering and managing Mobile Device Agents in enterprise environments—and mobile device users.

Administrators should have an intermediate to advanced knowledge of Windows system administration and mobile device policies, including:

- Installing and configuring Windows servers
- Installing software on Windows servers
- Configuring and managing mobile devices
- Network concepts (such as IP address, netmask, topology, and LAN settings)
- Various network topologies
- Network devices and their administration
- Network configurations (such as the use of VLAN, HTTP, and HTTPS)

Mobile Security Documentation

The Mobile Security documentation consists of the following:

- *Installation and Deployment Guide*—this guide helps you get “up and running” by introducing Mobile Security, and assisting with network planning and installation.

- *Administrator’s Guide*—this guide provides detailed Mobile Security configuration policies and technologies.

- *Online help*—the purpose of online help is to provide “how to’s” for the main product tasks, usage advice, and field-specific information such as valid parameter ranges and optimal values.

- *Readme*—the Readme contains late-breaking product information that is not found in the online or printed documentation. Topics include a description of new features, installation tips, known issues, and release history.
• Knowledge Base—the Knowledge Base is an online database of problem-solving and troubleshooting information. It provides the latest information about known product issues. To access the Knowledge Base, open:

http://esupport.trendmicro.com/

Tip
Trend Micro recommends checking the corresponding link from the Download Center (http://www.trendmicro.com/download) for updates to the product documentation.

Document Conventions

The documentation uses the following conventions.

TABLE 1. Document Conventions

<table>
<thead>
<tr>
<th>CONVENTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>UPPER CASE</td>
<td>Acronyms, abbreviations, and names of certain commands and keys on the keyboard</td>
</tr>
<tr>
<td>Bold</td>
<td>Menus and menu commands, command buttons, tabs, and options</td>
</tr>
<tr>
<td>Italic</td>
<td>References to other documents</td>
</tr>
<tr>
<td>Monospace</td>
<td>Sample command lines, program code, web URLs, file names, and program output</td>
</tr>
<tr>
<td>Navigation &gt; Path</td>
<td>The navigation path to reach a particular screen</td>
</tr>
<tr>
<td></td>
<td>For example, <strong>File &gt; Save</strong> means, click <strong>File</strong> and then click <strong>Save</strong> on the interface</td>
</tr>
<tr>
<td>Note</td>
<td>Configuration notes</td>
</tr>
<tr>
<td>Tip</td>
<td>Recommendations or suggestions</td>
</tr>
<tr>
<td>CONVENTION</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Important</strong></td>
<td>Information regarding required or default configuration settings and product limitations</td>
</tr>
<tr>
<td><strong>WARNING!</strong></td>
<td>Critical actions and configuration options</td>
</tr>
</tbody>
</table>
Chapter 1

Planning Server Installation

This chapter assists administrators in planning the server components for Trend Micro™ Mobile Security for Enterprise 9.8 SP3.

This chapter contains the following sections:

- *Architecture of Mobile Security System on page 1-2*
- *Enhanced Security Model (Dual Server Installation) with Cloud Communication Server on page 1-3*
- *Enhanced Security Model (Dual Server Installation) with Local Communication Server on page 1-4*
- *Basic Security Model (Single Server Installation) on page 1-5*
- *Components of Mobile Security System on page 1-5*
- *System Requirements on page 1-9*
- *Summary of Installation on page 1-12*
Architecture of Mobile Security System

Depending on your company needs, you can implement Mobile Security with different client-server communication methods. You can also choose to set up one or any combination of client-server communication methods in your network.

Trend Micro Mobile Security supports three different models of deployment:

• Enhanced Security Model (Dual Server Installation) with Cloud Communication Server
• Enhanced Security Model (Dual Server Installation) with Local Communication Server
• Basic Security Model (Single Server Installation)

Refer to the Installation and Deployment Guide for the details.
Enhanced Security Model (Dual Server Installation) with Cloud Communication Server

The Enhanced Security Model supports the deployment of Communication Server in the cloud. The following figure shows where each Mobile Security component resides in a typical Enhanced Security Model.

**Figure 1-1. Enhanced Security Model with Cloud Communication Server**
Enhanced Security Model (Dual Server Installation) with Local Communication Server

The Enhanced Security Model supports the installation of Communication Server and Management Server on two different computers. The following figure shows where each Mobile Security component resides in a typical Enhanced Security Model.

**Figure 1-2. Enhanced Security Model with Local Communication Server**
Basic Security Model (Single Server Installation)

The Basic Security Model supports the installation of Communication Server and Management Server on the same computer. The following figure shows where each Mobile Security component resides in a typical Basic Security Model.

**FIGURE 1-3. Basic Security Model**

Components of Mobile Security System

The following table provides the descriptions of the Mobile Security components.
### Table 1-1. Components of Mobile Security System

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>Required or Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Management Server</td>
<td>The Management Server enables you to manage Mobile Device Agents from the administration web console. Once mobile devices are enrolled to the server, you can configure Mobile Device Agent policies and perform updates.</td>
<td>Required</td>
</tr>
</tbody>
</table>
Trend Micro Mobile Security provides two types of Communication Server:  
- Local Communication Server (LCS)—this is a Communication Server deployed locally in your network.  
- Cloud Communication Server (CCS)—this is a Communication Server deployed in the cloud and you will not need to install this server. Trend Micro manages the Cloud Communication Server and you only need to connect to it from the Management Server. | Required             |
| SMS Senders          | You can use SMS Sender to send SMS text messages to the users.                                                                                                                                               | Optional             |
## Exchange Connector

Trend Micro Mobile Security uses Exchange Connector to communicate with the Microsoft Exchange server, detects all the mobile devices that use Exchange ActiveSync service, and displays them on Mobile Security web console.

The Microsoft Exchange server Integration with Mobile Security enables the administrators to monitor the mobile devices that access the Microsoft Exchange server. Once the feature is enabled and configured, Mobile Security administrators can perform Remote Wipe and block the access to the Microsoft Exchange server for such mobile devices.

The integration of Microsoft Exchange server with Mobile Security also enables the administrators to control the user access to cooperate data (such as, emails, calendar, contacts, and so on).

<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>DESCRIPTION</th>
<th>REQUIRED OR OPTIONAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exchange Connector</td>
<td>Trend Micro Mobile Security uses Exchange Connector to communicate with the Microsoft Exchange server, detects all the mobile devices that use Exchange ActiveSync service, and displays them on Mobile Security web console.</td>
<td>Optional</td>
</tr>
<tr>
<td>Mobile Device Agent (MDA)</td>
<td>The Mobile Device Agent is installed on the managed Android and iOS mobile devices. The agent communicates with the Mobile Security Communication Server and executes the commands and policy settings on the mobile device.</td>
<td>Required</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>The Microsoft SQL Server hosts the databases for Mobile Security Management Server.</td>
<td>Required</td>
</tr>
<tr>
<td>Active Directory</td>
<td>The Mobile Security Management Server imports users and groups from the Active Directory.</td>
<td>Optional</td>
</tr>
<tr>
<td>Certificate Authority</td>
<td>The Certificate Authority manages security credentials and public and private keys for secure communication.</td>
<td>Optional</td>
</tr>
</tbody>
</table>
**Component** | **Description** | **Required or Optional**
--- | --- | ---
SCEP | The Simple Certificate Enrollment Protocol (SCEP) is a communication protocol that provides a networked front end to a private certificate authority.

In some environments, it is important to make sure that corporate settings and policies are protected from prying eyes. To provide this protection, iOS allows you to encrypt profiles so that they can be read only by a single device. An encrypted profile is just like a normal configuration profile except that the configuration profile payload is encrypted with the public key associated with the device’s X.509 identity.

The SCEP works with the Certificate Authority to issue certificates in large enterprises. It handles the issuing and revocation of digital certificates. The SCEP and Certificate Authority can be installed on the same server. | Optional

APNs Certificate | (**Full Version** deployment mode, and **Security Scan** deployment mode with unlisted MDM vendor only.)
The Mobile Security Communication Server communicates through the Apple Push Notification Service (APNs) to iOS devices. | Required, if you want to manage iOS mobile devices

SSL certificate | (**Full Version** deployment mode, and **Security Scan** deployment mode with unlisted MDM vendor only.)
Trend Micro Mobile Security requires an SSL server certificate issued from a recognized Public Certificate Authority for the secure communication between mobile devices and Communication Server using HTTPS. | Required, if you want to manage iOS mobile devices
Comparison Between Local and Cloud Communication Servers

The following table provides the comparison between the Local Communication Server (LCS) and the Cloud Communication Server (CCS).

**TABLE 1-2. Comparison between Local and Cloud Communication Servers**

<table>
<thead>
<tr>
<th>FEATURES</th>
<th>CLOUD COMMUNICATION SERVER</th>
<th>LOCAL COMMUNICATION SERVER</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation required</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>User authentication method supported</td>
<td>Enrollment Key</td>
<td>Active Directory or Enrollment Key</td>
</tr>
<tr>
<td>Agent Customization for Android</td>
<td>Supported</td>
<td>Supported</td>
</tr>
</tbody>
</table>

System Requirements

Review the following requirements before installing each Mobile Security component in your network.
**TABLE 1-3. System Requirements**

<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>REQUIREMENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Management Server and Communication Server</td>
<td>Recommended Platforms</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2 Enterprise Edition</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 Enterprise Edition SP1</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 Standard Edition</td>
</tr>
<tr>
<td></td>
<td>• Windows Web Server 2008 Edition SP1</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2016</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2019</td>
</tr>
<tr>
<td></td>
<td>Other Platforms</td>
</tr>
<tr>
<td></td>
<td>• Windows 2008 Server Family</td>
</tr>
<tr>
<td></td>
<td>• Windows 2008 R2 Server Family</td>
</tr>
<tr>
<td></td>
<td>• Windows 2012 Server Family</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2012 R2 Family</td>
</tr>
<tr>
<td>Hardware</td>
<td>1-GHz Intel™ Pentium™ processor or equivalent</td>
</tr>
<tr>
<td></td>
<td>• At least 1-GB of RAM</td>
</tr>
<tr>
<td></td>
<td>• At least 400-MB of available disk space</td>
</tr>
<tr>
<td></td>
<td>• A monitor that supports 1024 x 768 resolution at 256 colors or higher</td>
</tr>
</tbody>
</table>
## Planning Server Installation

<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>REQUIREMENTS</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>IIS web Server for Management Server</td>
<td>Microsoft Internet Information Server (IIS) 7.0/7.5/8.0</td>
<td>• The IIS is the integral part of Microsoft Windows and the IIS version numbers correspond to the Windows version installed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Keep the default settings and select</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When using IIS 7.0 or above for Management Server, keep the default settings and enable and install <strong>CGI</strong> and <strong>ISAPI Extensions</strong> in Application Development, <strong>HTTP Redirection</strong> in Common HTTP Features, and <strong>IIS6 management compatibility</strong> in Management Tools.</td>
</tr>
<tr>
<td>SMS Sender</td>
<td>Android 2.1 or above</td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td>Microsoft Exchange Server</td>
<td>• Microsoft Exchange Server 2007</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Microsoft Exchange Server 2010</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Microsoft Exchange Server 2013</td>
<td></td>
</tr>
<tr>
<td>Web browser</td>
<td>• Internet Explorer 9.0 or above</td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>• Chrome 17 or above</td>
<td>Adobe Flash player is required for the Mobile Security administration web console.</td>
</tr>
<tr>
<td></td>
<td>• Firefox 14 or above</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Safari 6 or above on Mac</td>
<td></td>
</tr>
</tbody>
</table>
Component Requirements

SQL Server
- Microsoft SQL Server 2008
- Microsoft SQL Server 2008 Express Edition
- Microsoft SQL Server 2008 R2
- Microsoft SQL Server 2008 R2 Express Edition
- Microsoft SQL Server 2012
- Microsoft SQL Server 2012 Express Edition
- Microsoft SQL Server 2014
- Microsoft SQL Server 2014 Express Edition
- Microsoft SQL Server 2016
- Microsoft SQL Server 2016 Express Edition
- Microsoft SQL Server 2017
- Microsoft SQL Server 2017 Express Edition

Mobile Security Exchange Connector
Platform
- Windows Server 2008 R2 (64-bit)
- Windows Server 2012 (64 bit)
- Windows Server 2012 R2 (64 bit)
Hardware
- 1-GHz Intel™ Pentium™ processor or equivalent
- At least 1-GB of RAM
- At least 200-MB of available disk space
Other
- Microsoft .Net Framework 3.5 SP1

Summary of Installation

The following are the steps involved in installing Trend Micro Mobile Security:
1. Setting up environment for Mobile Security installation.

   See *Setting Up Environment for Mobile Security Installation on page 2-2* for details.

   a. Install Microsoft IIS web server on the computer where you plan to install the Management Server.

   See *Installing Microsoft IIS Web Server on page 2-6* for details.

   b. (Optional) Install database.

   If you skip this step at this stage, Mobile Security will automatically install Microsoft SQL Server 2017 Express edition during the installation.

   See *Installing SQL Server (Optional) on page 2-7* for details.

   c. (Optional) Set up the Active Directory account access rights.

   Perform this step if you want to import users from the corporate Active Directory server.

   See *Setting Up Active Directory Account Access Rights (Optional) on page 2-8* for details.

   d. (Optional) Install Microsoft Exchange Server Management Tools.

   Provides Exchange Server integration with the Management Server to manage Android and iOS mobile devices.

   See *Installing Microsoft Exchange Server Management Tools (Optional) on page 2-9* for details.

   e. Apply network access rules.

   See *Applying Network Access Rules for Mobile Security on page 2-9* for details.

2. (Optional) Setting up environment for iOS mobile devices.

   See *Setting Up Environment for iOS Mobile Devices (Optional) on page 2-3* for the details.

3. Installing server components.

   See *Installing Server Components on page 3-3* for the details.

See *Installing Management Server on page 3-4* for the detailed procedure.

b. Log on to Mobile Security for Enterprise administration web console.

See *Accessing the Administration Web Console on page 3-9* for the detailed procedure.

c. Register the product.

See *Registering the Product on page 3-11* for the detailed procedure.

d. (Optional) Download and install Local Communication Server (LCS).

You can skip this step if you plan to use the Cloud Communication Server (CCS).

See *Installing Local Communication Server on page 3-13* for the detailed procedure.

e. (Optional) Setup Exchange Server Integration.

You can skip this step if you do not want to manage mobile devices that use Exchange ActiveSync.

See *Installing Exchange Connector on page 3-19* for the detailed procedure.

i. Make sure that Microsoft Exchange Server Management Tools are installed.

See *Installing Microsoft Exchange Server Management Tools (Optional) on page 2-9* for the installation procedure.

ii. Configure an account for Exchange Connector.

Provides access rights for Exchange Connector.

See *Configuring Account for Exchange Connector on page 3-17* for the detailed procedure.

iii. Install Exchange Connector.

Establishes communication between Management Server and the Exchange Server.
Planning Server Installation

See Installing Exchange Connector on page 3-19 for the detailed procedure.

iv. Configure Exchange Server Integration Settings.

See Configuring Exchange Server Integration Settings on page 4-17 for the detailed procedure.


See Initial Server Setup on page 4-3 for details.

a. Configure server deployment settings.

See Configuring Deployment Settings on page 4-11 for the detailed procedure.

b. Configure Database settings.

See Configuring Database Settings on page 4-5 for the detailed procedure.

c. Configure Communication Server settings.

See Configuring Common Communication Server Settings on page 4-6 for the detailed procedure.

d. (Optional) Configure Communication Server settings for Android.

You can skip this step if you do not want to manage Android mobile devices.

See Configuring Android Communication Server Settings on page 4-8 for the detailed procedure.

e. (Optional) Configure Communication Server settings for iOS.

You can skip this step if you do not want to manage iOS mobile devices.

See Configuring iOS Communication Server Settings on page 4-9 for the detailed procedure.

f. Configure Device Enrollment settings.

See Configuring Device Enrollment Settings on page 4-12 for the detailed procedure.

g. (Optional) Customize the Mobile Security Terms of Use.
You can skip this step if you want to use the default Mobile Security Terms of Use.

See *Customizing Mobile Security Terms of Use on page 4-14* for the detailed procedure.

h. (Optional) Configure Active Directory settings.

You can skip this step if you do not want to import users from the Active Directory server.

See *Configuring Active Directory (AD) Settings on page 4-15* for the detailed procedure.

i. (Optional) Configure Management Server settings.

You can skip this step if your Management Server does not use proxy to access the Internet and you want to use the default server IP address and port number.

See *Configuring Management Server Settings on page 4-16* for the detailed procedure.

j. (Optional) Configure Exchange Server Integration Settings.

You can skip this step if you do not want to manage mobile devices that use Exchange ActiveSync.

See *Configuring Exchange Server Integration Settings on page 4-17* for the detailed procedure.

k. (Optional) Configure Notifications & Reports Settings.

You can skip this step if you do not want to send invitation email messages to users.

See *Configuring Notifications & Reports Settings on page 4-19*.

l. (Optional) Configure Administrator Notifications.

You can skip this step if you do not want to receive the error message notifications and regular scheduled reports via email.
Planning Server Installation

See *Configuring Administrator Notifications on page 4-20* for the detailed procedure.

m. Verify Mobile Security configuration (Recommended).

   See *Verifying Mobile Security Configuration on page 4-20* for the procedure.

n. Change the administrator account password for the administration web console.

   Refer to the topic *Editing Administrator Account in the Administrator's Guide* for the procedure.

5. Setting up Mobile Device Agent.

   *Setting Up Mobile Device Agent on page 5-3*

   a. (Optional) Configure notifications settings for mobile devices.

      See *Configuring Notifications & Reports Settings on page 4-19* for the detailed procedure.

   b. (Optional) Configure the installation message that Mobile Security sends in an email and/or a text message to the users.

      The installation message includes the URL that users can access to download and install the MDA setup package.

      See *Configuring Installation Message on page 5-4* for the detailed procedure.

   c. (Optional) Send invitation to users.

      See *Inviting a User to Register on page 5-5* for the detailed procedure.

   d. Install MDA on mobile devices.

      See *Installing MDA on Mobile Devices on page 5-9* for the detailed procedure.

   e. Enrolling MDA with the Management Server.

      See *Enrolling MDA to the Mobile Security Management Server on page 5-15* for the detailed procedure.
Chapter 2

Setting Up Environment

This chapter provides the information that you will need to set up your environment before you install Trend Micro™ Mobile Security for Enterprise 9.8 SP3.

This chapter contains the following sections:

- Setting Up Environment for Mobile Security Installation on page 2-2
- Setting Up Environment for iOS Mobile Devices (Optional) on page 2-3
- Installing Microsoft IIS Web Server on page 2-6
- Installing SQL Server (Optional) on page 2-7
- Setting Up Active Directory Account Access Rights (Optional) on page 2-8
- Applying Network Access Rules for Mobile Security on page 2-9
- Installing Microsoft Exchange Server Management Tools (Optional) on page 2-9
Setting Up Environment for Mobile Security Installation

The following table depicts the process of setting up environment for Mobile Security installation.

**TABLE 2-1. Process of setting up environment for Mobile Security installation**

<table>
<thead>
<tr>
<th>STEP</th>
<th>ACTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Install Microsoft IIS Web server on the computer where you plan to install the Management Serverp.</td>
<td>See <em>Installing Microsoft IIS Web Server on page 2-6</em> for details.</td>
</tr>
<tr>
<td>Step 2</td>
<td>(Optional) Install database.</td>
<td>If you skip this step now, Mobile Security will automatically install Microsoft SQL Server 2017 Express edition during the installation. See <em>Installing SQL Server (Optional) on page 2-7</em> for details.</td>
</tr>
<tr>
<td>Step 3</td>
<td><em>(Full Version deployment mode, and Security Scan deployment mode with unlisted MDM vendor only.)</em> (Optional) Set up the Active Directory account access rights.</td>
<td>Perform this step if you want to import users from the corporate Active Directory server. See <em>Setting Up Active Directory Account Access Rights (Optional) on page 2-8</em> for details.</td>
</tr>
</tbody>
</table>

Step 6 (Optional) Set up environment to manage iOS mobile devices. If you want to manage iOS mobile devices, this step is compulsory. See Setting Up Environment for iOS Mobile Devices (Optional) on page 2-3.

---

**Setting Up Environment for iOS Mobile Devices (Optional)**

**WARNING!**

Before setting up the environment to manage iOS mobile devices, make sure you have performed all the steps mentioned in the following table.

The following table depicts the process of setting up environment to manage iOS mobile devices.

**TABLE 2-2. Process of setting up environment for iOS mobile devices**

<table>
<thead>
<tr>
<th>STEP</th>
<th>ACTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>(Full Version deployment mode, and Security Scan deployment mode with unlisted MDM vendor only.) Set up Apple Push Notification service (APNs) certificate.</td>
<td>If you want to manage iOS mobile devices, you need to set up the APNs certificate. See Generating and Configuring APNs Certificate on page C-1 for the detailed procedure.</td>
</tr>
<tr>
<td>STEP</td>
<td>ACTION</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Step 2</td>
<td>(Full Version deployment mode only.) (Optional) Obtain an SSL server</td>
<td>SSL certificate provides secure communication between mobile devices and Communication Server.</td>
</tr>
<tr>
<td></td>
<td>certificate from a recognized Public Certificate Authority.</td>
<td>If you want to manage iOS mobile devices or plan to use the Local Communication Server, then this step is mandatory. You will need to import a</td>
</tr>
<tr>
<td></td>
<td></td>
<td>public SSL certificate during the Local Communication Server installation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can skip this step:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• if you want to use a private SSL certificate. Mobile Security will create it during the Local Communication Server installation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• if you plan to use the Cloud Communication Server.</td>
</tr>
</tbody>
</table>
### Step 3

**Full Version** deployment mode only.

(Optional) Set up Simple Certificate Enrollment Protocol (SCEP) for additional security.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 3    | (Full Version deployment mode only.) (Optional) Set up Simple Certificate Enrollment Protocol (SCEP) for additional security | Provides secure communication between mobile devices and Communication Server.  
See *Setting Up SCEP on page B-5* for details.  
If you already have SCEP set up in your environment, you can skip this step. |

**Note**

If you do not want to use SCEP for iOS mobile devices, you will need to disable it in Communication Server Settings after you have installed the Management Server and the Communication Server. Refer to *Configuring iOS Communication Server Settings on page 4-9* for the procedure.
<table>
<thead>
<tr>
<th><strong>STEP</strong></th>
<th><strong>ACTION</strong></th>
<th><strong>DESCRIPTION</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 4</td>
<td>Configure network ports 2195 (TCP) on the Local Communication Server and 5223 on the Wi-Fi network</td>
<td>TCP port 2195 allows outbound connection from Communication Server to Apple Push Notification Service on TCP port 2195. The hostname of Apple Push Notification Service is <code>gateway.push.apple.com</code>. Port 5223 allows iOS devices to receive a push notification from Apple’s server especially when connecting through a Wi-Fi network where port 5223 is blocked. However, if the mobile devices are on a 3G network, you do not need to configure this port. See Network Ports Configurations on page A-1 for the complete network ports configuration.</td>
</tr>
</tbody>
</table>

### Installing Microsoft IIS Web Server

This task is a step in the process of setting up environment for Mobile Security installation.


**Procedure**

- Navigate to one of the following URLs for the installation procedure of IIS:
  - For Windows 2008 or Windows Server 2008 R2 (IIS 7.0 or 7.5)
    
    http://www.iis.net/learn/install/installing-iis-7
  - For Windows 2012 (IIS 8.0)
    
    http://www.iis.net/learn/get-started/whats-new-in-iis-8/installing-iis-8-on-windows-server-2012
**Setting Up Environment**

---

**Note**

When using IIS 7.0 or above for Management Server, keep the default settings, and enable and install **CGI** and **ISAPI Extensions** in Application Development, **HTTP Redirection** in Common HTTP Features, and **IIS6 management compatibility** in Management Tools.

---

**Installing SQL Server (Optional)**

---

**Note**

You can skip this step if you do not want to install any specific SQL server version. Mobile Security will automatically install Microsoft SQL Server 2017 Express edition during the installation.

This task is a step in the process of setting up environment for Mobile Security installation.

See *Setting Up Environment for Mobile Security Installation on page 2-2*.

---

**Procedure**

- Navigate to one of the following URLs for the installation procedure of SQL Server:
  - For Microsoft SQL Server 2008/2008 R2 (or Express edition):
    
  - For Microsoft SQL Server 2012 (or Express edition):
    
Note

Trend Micro recommends using SQL Server Authentication method for SQL Server instead of Windows Authentication. However, you can also configure Windows Authentication for SQL Server. Refer to Using Windows Authentication for SQL Server on page B-2 for details.

Setting Up Active Directory Account Access Rights (Optional)

Note

This topic applies to Full Version and Security Scan deployment mode with unlisted MDM vendor only.

Note

You only need to perform this step if you plan to use Active Directory for user authentication or import users from Active Directory. Otherwise, skip this step.

If you have not already installed the Active Directory, refer to the following URL for the detailed installation procedure:


This task is a step in the process of setting up environment for Mobile Security installation.


Procedure

- Create an Active Directory Service Account for Mobile Security 9.8 SP3 and assign it at least Read-Only access to Active Directory. Refer to the following URL for creating an active directory account for Windows 2008:

Installing Microsoft Exchange Server Management Tools (Optional)

Note
This topic applies to Full Version deployment mode only.

Microsoft Exchange Server Management Tools provide Exchange Server integration with the Management Server to manage Android and iOS mobile devices.

This task is a step in the procedure of setting up environment for Mobile Security installation.


Procedure

- Navigate to one of the following URLs for the installation procedure of Exchange Server Management Tools:
  - For installing Exchange Server Management Tools 2007:
  - For installing Exchange Server Management Tools 2010:
    http://technet.microsoft.com/library/bb232090(v=EXCHG.141)
  - For installing Exchange Server Management Tools 2013:

Applying Network Access Rules for Mobile Security

This task is a step in the process of setting up environment for Mobile Security installation.
See *Setting Up Environment for Mobile Security Installation on page 2-2.*

**Procedure**

- Apply the following network access rules:
  - If you plan to use Active Directory, the Management Server should be able to connect to the Active Directory server. If you are using a firewall, make sure to add an exception in the firewall settings for the Management Server.
  - The Management Server should be able to connect to the SQL server, where the Trend Micro Mobile Security database is installed. If you are using a firewall, make sure to add an exception in the firewall settings on both SQL server and Management Server.
  - Add an exception for port 4343 to ensure an HTTPS connection between the Management Server and the Communication Server:
    
    If you need to customize this port number, refer to [Configuring Communication Server Ports on page B-4](#) for details.
  - Add exception for port numbers 80 and 443 to ensure that all mobile devices are able to connect to the Communication Server.
Chapter 3

Installing, Updating and Removing Server Components

This chapter guides the administrators in installing Trend Micro™ Mobile Security for Enterprise 9.8 SP3 server components. This chapter also guides on how to remove the server components.

This chapter contains the following sections:

• Installing Server Components on page 3-3
• Before You Install on page 3-3
• Installation Workflow for Trend Micro Mobile Security on page 3-3
• Installing Management Server on page 3-4
• Accessing the Administration Web Console on page 3-9
• Registering the Product on page 3-11
• Installing Local Communication Server on page 3-13
• Setting Up Exchange Server Integration on page 3-16
• Configuring Account for Exchange Connector on page 3-17
• Installing Exchange Connector on page 3-19
• *About Mobile Security Upgrade on page 3-22*

• *Removing Server Components on page 3-27*
Installing Server Components

Before You Install

Before you proceed to install Mobile Security server components:

• make sure the Mobile Security components meet the specified system requirements.

See System Requirements on page 1-9. You may also need to evaluate your network topology and determine the Mobile Security server components you want to install.

• make sure you have already performed all the prerequisite steps mentioned in the chapter Setting Up Environment on page 2-1.

Installation Workflow for Trend Micro Mobile Security

The following table depicts the basic approach to installing Trend Micro Mobile Security.

| TABLE 3-1. Installation workflow for Trend Micro Mobile Security |
|-------------------------|--------------------------|
| **STEP** | **ACTION** | **DESCRIPTION** |
| Step 1 | Install Mobile Security Management Server. | See Installing Management Server on page 3-4 for the detailed procedure. |
| Step 2 | Log on to Mobile Security for Enterprise administration Web console. | See Accessing the Administration Web Console on page 3-9 for the detailed procedure. |
| Step 3 | Register the product. | See Registering the Product on page 3-11 for the detailed procedure. |
### Step 4 (Optional) Download and install Local Communication Server.

You can skip this step if you plan to use the Cloud Communication Server (CCS).

See [Installing Local Communication Server on page 3-13](#) for the detailed procedure.

### Step 5 (Optional) Install SMS Sender

You can skip this step if you do not want to send SMS notifications to users.

See [Installing SMS Sender on page 3-16](#) for the detailed procedure.

### Step 6 (Full Version deployment mode only.) (Optional) Install Exchange Connector

You can skip this step if you do not want to manage mobile devices that use Exchange ActiveSync.

See [Installing Exchange Connector on page 3-19](#) for the detailed procedure.

## Installing Management Server

**Note**

Mobile Security requires OpenJDK to upload .apk file from the Application Management module on the Management Server. The OpenJDK is automatically downloaded during the installation of Management Server.

## Procedure

1. Download the Management Server installation program from the following location:

2. Extract the downloaded file and then run the Management Server installation program: MdmServerSetup.exe.

The **Welcome** screen displays.

3. Click **Next**.

The **License Agreement** screen displays.

4. Select the **I agree** checkbox and click **Next**.

---

**Note**

Mobile Security requires you to install Microsoft Visual C++ 2015 Redistributable files. If you have already installed it on your computer, the Microsoft Visual C++ 2015 Redistributable files installation steps will not appear during installation. If Microsoft Visual C++ 2015 Redistributable files installation screen display, click **Next** on the screens to continue the installation.
The **Database Options** screen displays.

![Database Options Screen](image)

**Figure 3-1. The Database Options screen**

5. Do one of the following:

   - If you do not have any database installed or want to create a new database for Mobile Security:
     
     a. Select **Install Microsoft SQL server 2017 Express on this computer**, and click **Next**.
The Database Setup screen displays.

![Database Setup screen](image)

**FIGURE 3-2. Database Setup screen for new database**

b. Type a password for your new database and click **Next**.

The Setup Progress screen appears and displays the current installation status.

c. After the setup completes, click **Next**.

The Server Connection Settings screen displays.

- If you already have a database installed and want to use the existing database:
  a. Select **Connect to an existing database** and click **Next**.
The **Existing Database** screen displays.

![Existing Database Screen](image)

**FIGURE 3-3. Existing database server information**

b. Type your existing database server information and click **Next**

The **Server Connection Settings** screen displays.

6. Select the IP address from the drop-down list and type the server port number and click **Next**.

7. Select a location where you want to install Mobile Security and click **Next**.

---

**Note**

Click **Change** to select a different location.

---

8. Click **Install** to start the installation.

The installation progress window appears. After the installation is complete, the **Trend Micro Mobile Security Installation Completed** screen displays.
9. Click Finish.

What to do next

See Installation Workflow for Trend Micro Mobile Security on page 3-3 for the next configuration task.

Accessing the Administration Web Console

Procedure

1. Log on to the administration web console using the following URL structure:

   https://
   <External_domain_name_or_IP_address>:<HTTPS_port>/mdm/web

   **Note**
   Replace <External_domain_name_or_IP_address> with the actual IP address, and <HTTPS_port> with the actual port number of the Management Server.

   The following screen appears.

   ![Administration Web console login screen](image)

   **FIGURE 3-4. Administration Web console login screen**
2. Type a user name and password in the fields provided and click **Log In**.

   **Note**
   
   The default **User Name** for administration web console is “root” and the **Password** is “mobilesecurity”.
   
   Make sure that you change the administrator password for the user "root" after your first sign in. See **Editing an Administrator Account** in the **Administrator's Guide** for the procedure.

   **Important**
   
   - the **Compatibility View for Websites** options is turned off. See **Turning Off Compatibility Mode in Internet Explorer** on page 3-10 for details.
   
   - the JavaScript is enabled on your browser.

   **Note**
   
   If you are unable to access the administration web console in Windows 2012 using Internet Explorer 10 in Metro mode, verify that the **Enhanced Protected Mode** option is disabled in Internet Explorer.

**Turning Off Compatibility Mode in Internet Explorer**

Trend Micro Mobile Security does not support **Compatibility View** on Internet Explorer. If you are using Internet Explorer to access the Mobile Security administration web console, turn off the web browser’s Compatibility View for the website, if it is enabled.

**Procedure**

1. Open Internet Explorer and click **Tools > Compatibility View settings**.

   The **Compatibility View Settings** window displays.

2. If the administration console is added to the **Compatibility View** list, select the website and click **Remove**.
3. Clear **Display intranet sites in Compatibility View** and **Display all websites in Compatibility View** checkboxes, and then click **Close**.

### Registering the Product

Trend Micro provides all registered users with technical support, malware pattern downloads, and program updates for a specified period after which you must purchase renewal maintenance to continue receiving these services. Register Mobile Security server to ensure that you are eligible to receive the latest security updates and other product and maintenance services.

You only need to register Mobile Security server on the Management Server using the Activation Code. Mobile Device Agents automatically obtain license information from the Mobile Security server after the mobile devices are connected and registered to the server.

An activation code displays in the following format:

```
xx-xxxx-xxxxx-xxxx-xxxxx-xxxxx-xxxxx-xxxxx
```

### Procedure

1. Log on to the Mobile Security administration web console.

   If this is the first time you access the management console, the **Product License** screen displays; otherwise, click **Administration > Product License** and click **New Activation Code**.

2. Type the Activation Code in the fields provided and click **Save**.

![Figure 3-5. Registering Mobile Security after installation](image)
3. Verify that product registration is successful. Click **Dashboard** to display the Dashboard screen.

You should see the message “Trend Micro Mobile Security 9.8 SP3 has been activated.” if product registration is successful.

After the registration is complete, the **Mobile Security Configuration and Verification** screen displays and guides you through the steps to complete the initial settings.

![Mobile Security Configuration and Verification](image)

**FIGURE 3-6. Mobile Security Configuration and Verification screen**

### What to do next

See *Installation Workflow for Trend Micro Mobile Security on page 3-3* for the next configuration task.
Installing Local Communication Server

Procedure

1. Log on to the administration web console on the computer where you want to install the Communication Server.

2. Click Administration > Communication Server Settings.

3. Click the Common Settings tab.

4. Select the Local Communication Server from the drop-down list and then click Click here to download.

5. Double-click the setup file to start the installation process.

The Welcome screen displays.

6. Click Next.

The License Agreement screen displays.

7. Select the I accept the terms in the license agreement and click Next.

The Communication Server Connection Settings for Mobile Devices screen appears.

8. Select an IP address from the drop-down list, and type HTTP and HTTPs port numbers for the Communication Server.

The IP address and port number on this screen are used for the Communication Server to communicate with the mobile devices.

Note

Trend Micro recommends selecting "ALL" for IP address.

9. Click Next.

The Communication Server Connection Settings for Management Server screen appears.
10. Select an IP address from the drop down list, and type an HTTPs port number for the Communication Server.

The IP address and port number on this screen are used for the Communication Server to communicate with the Management Server.

**Note**

Trend Micro recommends selecting "ALL" for IP address.

11. Click Next.

The **Server Certificate** screen appears.

12. Do one of the following:

   • If you already have an SSL certificate for iOS mobile device enrollment, do the following:
     a. Select **Import an existing .pfx or .p12 certificate file** and click Next.
     
        The **Import Certificate** screen displays.
     b. Click **Browse** and select the public certificate from the hard drive.
     c. Type certificate password in the **Password** field. Leave this field blank, if the certificate does not have a password.
     d. Click **Next**.

   • If you do not have an SSL certificate for iOS mobile device enrollment, or need to create a new one, do the following:
     a. Select **Create a new private certificate** and click Next.
     
        The **Create Certificate** screen displays.
     b. Type the Communication Server IP address in the **Common Name** field and a certificate password in the **Password** field.
     c. Click **Next**.

13. Select a location where you want to install Mobile Security and then click **Next**.
14. Click **Install** to start the installation.

The installation progress window appears. After the installation is complete, the **Installation Completed** screen displays.

15. Click **Finish**.

---

**What to do next**

See *Installation Workflow for Trend Micro Mobile Security on page 3-3* for the next configuration task.

---

**SMS Sender**

You can use SMS Sender to send SMS messages to the users.

SMS senders are designated Android mobile devices connected to the Management Server over network connections. An SMS sender receives commands from server and relays them to mobile devices via SMS text messages.

SMS text messages may be used to notify mobile devices to:

- download and install Mobile Device Agent
- enroll Mobile Device Agent to the Mobile Security server
- update the Mobile Device Agent components from the Mobile Security server
- synchronize policies with the Mobile Security server
- wipe, lock or locate the remote mobile device
Installing SMS Sender

**Note**
If you do not use SMS Sender, only the remote lock and remote wipe instructions will not be pushed to the Windows Mobile devices. However, all other features will work as normal. Also, if you do not use SMS Sender, all the features of Mobile Security will work as normal for iOS, Android, BlackBerry and Symbian mobile devices.

**Procedure**

1. On the Management Server, copy the setup file from the folder \Mobile Security\SmsSender to a memory card for the supported device.

2. Insert the memory card to the device and run the setup file to install the SMS Sender program.
   
   After the installation is complete, the SMS Sender application icon appears in the application list.

**What to do next**

See *Installation Workflow for Trend Micro Mobile Security on page 3-3* for the next configuration task.

Setting Up Exchange Server Integration

**Note**
This topic applies to **Full Version** deployment mode only.

Exchange Server integration is required to establish the communication between Management Server and the Exchange Server.

**Note**
Trend Micro Mobile Security supports Exchange Server 2007 or later only, and provides Exchange Server Integration support for iOS and Android mobile devices.
The following table depicts the process of setting up Exchange Server Integration for Trend Micro Mobile Security.

**TABLE 3-2. Process for setting up Exchange Server Integration**

<table>
<thead>
<tr>
<th>STEP</th>
<th>ACTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Configure an account for Exchange Connector.</td>
<td>Provides access rights for Exchange Connector. See <em>Configuring Account for Exchange Connector on page 3-17</em> for the detailed procedure.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Configure Exchange Server Integration Settings.</td>
<td>See <em>Configuring Management Server Settings on page 4-16</em> for the detailed procedure.</td>
</tr>
</tbody>
</table>

**Configuring Account for Exchange Connector**

---

**Note**

This topic applies to **Full Version** deployment mode only.
Procedure

1. Create a user account in Active Directory server.

2. On to the computer where you want to install Exchange Connector, navigate to Start > Administrator Tools > Computer Management and do the following.
   a. Expand the Local Users and Groups folder from the left tree, and then double-click Groups.
   b. Right-click Administrators and click Properties.
   c. Click Add button on the General tab, and do the following:
      i. Type the user name that you created in step 1 of this procedure in the Login name field and click Search.
      ii. Type the user name with the domain name (for example: domainname \username) in the Enter the object name to select field and click Check Names.
      iii. Click OK.
   d. Click OK on the Administrator Properties dialog box.

3. On to the Active Directory server, do the following:
   b. Expand the Users folder from the left tree.
   c. Right-click the account (user name) you created in step 1 of this procedure and click Add to a group.
   d. Do one of the following:
      • For Exchange Server 2007, type Exchange Organization Administrators in the Enter the object name to select field and click Check Names.
• For Exchange Server 2010 and 2013, type **Organization Management** in the **Enter the object name to select** field and click **Check Names**.

e. Click **OK** and then click **OK** on the confirmation screen.

4. On the Active Directory server, do the following:

a. Navigate to **Start > Administrative Tools > Active Directory Users and Computers**.

b. From the menu bar, click **View > Advanced Features**.

c. Expand the Users folder from the left tree.

d. Right-click the account (user name) you created in step 1 of this procedure and click **Properties**.

e. On the **Security** tab, click **Add**.

f. Type the user name you created in step 1 with the domain name (for example: `domainname\username`) in the **Enter the object name to select** field, click **Check Names**, and then click **OK**.

g. Select the user name in **Group or user name** list, and click **Advanced**.

h. Select **Include inheritable permissions from this object’s parent** and click **OK**.

i. Click **OK** on the **Properties** dialog box.

---

### Installing Exchange Connector

**Note**

This topic applies to **Full Version** deployment mode only.
**Note**

You must install the Exchange Connector on the computer:

- where Microsoft Exchange Server Management Tools are installed,
- which is in the same domain as Exchange Server, and
- should be able to connect to the Management Server.

---

**Procedure**

1. Log on to the Mobile Security administration web console.
2. Click **Administration > Exchange Server Integration**.
3. Click **Click here to download** and save the `ExchangeConnector.zip` file on your computer.
   
   The Exchange Connector setup wizard appears.
5. Click **Next** on the **Welcome** screen.
6. Select **I accept the terms in the license agreement** and click **Next**.
The setup now checks if the Microsoft Exchange Management Tools are installed on the computer. If they are installed, setup displays the following screen.

**FIGURE 3-7. Successful Exchange Management installation check**

7. Click **Next** on the **Checking System Requirements** screen.

8. Click **Browse** and select the destination folder where you want to install the Exchange Connector, and then click **Next**.

The **Service Account** screen displays.

9. Type the user name, password and domain name (that you created in *Configuring Account for Exchange Connector on page 3-17*) to access the Exchange Management Tools, and click **Next**.
10. Review the settings on the **Review Settings** screen and click **Install**.

    The setup starts installing the Exchange Connector.

11. When the installation completes, click **Next** and then click **Finish**.

---

**Note**

The time it takes to import mobile devices information from the Exchange Server to the Management Server depends on the number of mobile devices you want to import. For example, it may take up to several hours to import the information of 5000 mobile devices from the Exchange Server to Management Server.

---

**What to do next**

See *Installation Workflow for Trend Micro Mobile Security on page 3-3* for other configuration tasks.

---

**Updating Components**

**About Mobile Security Upgrade**

Trend Micro Mobile Security only supports upgrades from version 9.0 or later.

In Mobile Security, the following components or files are updated through ActiveUpdate, the Trend Micro Internet-based component update feature:

- Malware Pattern—file containing thousands of malware signatures, and enables Mobile Security to detect these hazardous files. Trend Micro updates pattern files regularly to ensure protection against the latest threats.
- Mobile Device Agents installation program—program installation package for the Mobile Device Agents.
Trend Micro Mobile Security only supports upgrades from version 9.0 or later. For upgrades from a version older than 9.0, Trend Micro provides a Migration Tool to migrate your data from an older version to v9.0. You can then upgrade to Mobile Security v9.8 SP3.

Refer to the following link for the detailed procedure of migrating your data from an older version to v9.8 SP3:


About Component Updates

In Mobile Security, the following components or files are updated through ActiveUpdate, the Trend Micro Internet-based component update feature:


• Malware Pattern—file containing thousands of malware signatures, and determines the ability of Mobile Security to detect hazardous files. Trend Micro updates pattern files regularly to ensure protection against the latest threats.

• Mobile Device Agents installation program—program installation package for the Mobile Device Agents.

Updating Mobile Security Components

You can configure scheduled or manual component updates on the Mobile Security Management Server to obtain the latest component files from the ActiveUpdate server. After a newer version of a component is downloaded on the Management Server, the Management Server automatically notifies mobile devices to update components.

Conref - Manual Update

You can perform a manual server and Mobile Device Agent update in the Manual tab on Updates screen. You should have already configured the download source in the Source screen (see Specifying a Download Source on page 3-25 for more information).
Procedure

1. Log on to the Mobile Security administration web console.

2. Click Administration > Updates.
   
The Updates screen displays.

3. Click the Manual tab.

4. Select the check box of the component you want to update. Select the Anti-Malware Components, Agent Installation Packages and/or Server Version check box(es) to select all components in that group. This screen also displays the current version of each component and the time the component was last updated.

   See About Component Updates on page 3-23 for more information on each update component.

5. Click Update to start the component update process.

Scheduled Update

Scheduled updates allow you to perform regular updates without user interaction; thereby, reducing your workload. You should have already configured the download source in the Source screen (refer to Specifying a Download Source on page 3-25 for more information).

Procedure

1. Log on to the Mobile Security administration web console.

2. Click Administration > Updates.
   
The Updates screen displays.

3. Click the Scheduled tab.

4. Select the check box of the component you want to update. Select the Anti-Malware Components, Agent Installation Packages and/or Server Version check box(es) to select all components in that group. This screen also displays each component’s current version and the time the component was last updated.
5. Under **Update Schedule**, configure the time interval to perform a server update. The options are **Hourly**, **Daily**, **Weekly**, and **Monthly**.

   - For weekly updates, specify the day of the week (for example, Sunday, Monday, and so on.)
   - For monthly updates, specify the day of the month (for example, the first day, or 01, of the month and so on).

   **Note**

   The **Update for a period of x hours** feature is available for the **Daily**, **Weekly**, and **Monthly** options. This means that your update will take place sometime within the number of hours specified, following the time selected in the **Start time** field. This feature helps with load balancing on the ActiveUpdate server.

   - Select the **Start time** when you want Mobile Security to initiate the update process.

6. Click **Save** to save the settings.

---

**Specifying a Download Source**

You can set Mobile Security to use the default ActiveUpdate source or a specified download source for server update.

**Procedure**

1. Log on to the Mobile Security administration web console.

2. Click **Administration** > **Updates**.

   The **Updates** screen displays. For more information about the update see *Conref - Manual Update on page 3-23* or for scheduled update see *Scheduled Update on page 3-24*.

3. Click the **Source** tab.

4. Select one of the following download sources:
• **Trend Micro ActiveUpdate server**—the default update source.

• **Other update source**—specify HTTP or HTTPS website (for example, your local Intranet website), including the port number that should be used from where Mobile Device Agents can download updates.

---

**Note**
The updated components have to be available on the update source (web server). Provide the host name or IP address, and directory (for example, `https://12.1.123.123:14943/source`).

---

• **Intranet location containing a copy of the current file**—the local intranet update source. Specify the following:
  
  • **UNC path**: type the path where the source file exists.
  
  • **Username** and **Password**: type the username and password if the source location requires authentication.

---

**Manually Updating a local AU server**

If the Server/Device is updated through a Local AutoUpdate Server, but the Management Server cannot connect to the Internet; then, manually update the local AU Server before doing a Server/Device Update.

---

**Procedure**

1. Obtain the installation package from your Trend Micro representative.

2. Extract the installation package.

3. Copy the folders to the local AutoUpdate Server.

---

**Note**
When using a local AutoUpdate Server, you should check for updates periodically.
Removing Server Components

This section guides you through the steps you need to perform to remove the Management Server and the Communication Server.

Procedure

1. From the Windows Control Panel, double-click Programs and Features.
   The Uninstall or change a program window displays.

2. Select one of the following:
   - Trend Micro Local Communication Server—to uninstall Communication Server
   - Trend Micro Mobile Security—to uninstall Management Server

3. Click Uninstall.
   A dialog box displays.

4. On the dialog box, select Automatically close applications and attempt to restart them after setup is complete and click OK.
Chapter 4

Configuring Server Component

This chapter assists administrators in configuring the server components for Trend Micro™ Mobile Security for Enterprise 9.8 SP3.

This chapter contains the following sections:

• Initial Server Setup on page 4-3
• Configuring Database Settings on page 4-5
• Configuring Communication Server Settings on page 4-6
• Configuring Common Communication Server Settings on page 4-6
• Configuring Android Communication Server Settings on page 4-8
• Configuring iOS Communication Server Settings on page 4-9
• Configuring Device Enrollment Settings on page 4-12
• Customizing Mobile Security Terms of Use on page 4-14
• Configuring Active Directory (AD) Settings on page 4-15
• Configuring Management Server Settings on page 4-16
• Configuring Exchange Server Integration Settings on page 4-17
• Exchange Connector Statuses on page 4-18
• Configuring Notifications & Reports Settings on page 4-19
• Configuring Administrator Notifications on page 4-20
• Verifying Mobile Security Configuration on page 4-20
Initial Server Setup

The following table depicts the initial server setup of Trend Micro Mobile Security after installation.

**TABLE 4-1. Initial setup of Mobile Security server**

<table>
<thead>
<tr>
<th>STEP</th>
<th>ACTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Configure Database settings.</td>
<td>See <em>Configuring Database Settings on page 4-5</em> for the detailed procedure.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Configure Communication Server settings.</td>
<td>See <em>Configuring Common Communication Server Settings on page 4-6</em> for the detailed procedure.</td>
</tr>
<tr>
<td>Step 3</td>
<td><em>(Full Version deployment mode only.)</em> (Optional) Configure Communication Server settings for Android.</td>
<td>You can skip this step if you do not want to manage Android mobile devices. See <em>Configuring Android Communication Server Settings on page 4-8</em> for the detailed procedure.</td>
</tr>
<tr>
<td>Step 4</td>
<td><em>(Full Version deployment mode only.)</em> (Optional) Configure Communication Server settings for iOS.</td>
<td>You can skip this step if you do not want to manage iOS mobile devices. See <em>Configuring iOS Communication Server Settings on page 4-9</em> for the detailed procedure.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Configure Deployment Mode settings.</td>
<td>See <em>Configuring Deployment Settings on page 4-11</em> for the detailed procedure.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Configure Device Enrollment settings.</td>
<td>See <em>Configuring Device Enrollment Settings on page 4-12</em> for the detailed procedure.</td>
</tr>
<tr>
<td>Step 7</td>
<td><em>(Full Version deployment mode only.)</em> (Optional) Customize the Mobile Security Terms of Use.</td>
<td>You can skip this step if you want to use the default Mobile Security Terms of Use. See <em>Customizing Mobile Security Terms of Use on page 4-14</em> for the detailed procedure.</td>
</tr>
<tr>
<td>STEP</td>
<td>ACTION</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Step 8</td>
<td>(Full Version deployment mode, and Security Scan deployment mode with unlisted MDM vendor only.) (Optional) Configure Active Directory settings.</td>
<td>You can skip this step if you do not want to import users from the Active Directory server. See Configuring Active Directory (AD) Settings on page 4-15 for the detailed procedure.</td>
</tr>
<tr>
<td>Step 9</td>
<td>(Optional) Configure Management Server settings.</td>
<td>You can skip this step if you do not want to import users from the Active Directory server. See Configuring Management Server Settings on page 4-16 for the detailed procedure.</td>
</tr>
<tr>
<td>Step 10</td>
<td>(Full Version deployment mode only.) (Optional) Configure Exchange Server Integration Settings.</td>
<td>You can skip this step if you do not want to manage mobile devices that use Exchange ActiveSync. See Configuring Exchange Server Integration Settings on page 4-17 for the detailed procedure.</td>
</tr>
<tr>
<td>Step 11</td>
<td>(Optional) Configure Notifications &amp; Reports Settings.</td>
<td>You can skip this step if you do not want to send invitation email messages to users. See Configuring Notifications &amp; Reports Settings on page 4-19 for the detailed procedure.</td>
</tr>
<tr>
<td>Step 12</td>
<td>(Optional) Configure Administrator Notifications.</td>
<td>You can skip this step if you do not want to receive the error message notifications and regular scheduled reports via email. See Configuring Administrator Notifications on page 4-20 for the detailed procedure.</td>
</tr>
</tbody>
</table>
### Configuring Server Component

<table>
<thead>
<tr>
<th>STEP</th>
<th>ACTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 13</td>
<td>Verify Mobile Security configuration (Recommended).</td>
<td>Use the <strong>Configuration and Verification</strong> screen to verify the Mobile Security configurations. See <a href="#">Verifying Mobile Security Configuration on page 4-20</a> for the procedure.</td>
</tr>
<tr>
<td>Step 14</td>
<td>Change the administrator account password for the administration web console.</td>
<td>Use the <strong>Administration Account Management</strong> screen after logging into the administration web console. Refer to the topic <em>Editing Administrator Account</em> in the <em>Administrator’s Guide</em> for the procedure.</td>
</tr>
</tbody>
</table>

**Note**

You must complete the initial server setup for the Mobile Security server before you continue to install Mobile Device Agent on mobile devices.

### Configuring Database Settings

**Procedure**

1. Log on to the administration web console.
2. Click **Administration > Database Settings**.
3. Type the server name or IP address, your user name, password and the database name.

**Note**

If you are using a specific port for SQL server or SQL Server Express, use the following format:

```
<SQL server name or IP address>,<Port>
```

4. Click **Save**.
What to do next

See Initial Server Setup on page 4-3 for the next configuration task.

Configuring Communication Server Settings

Communication Server Settings screen provides the following settings:

• **Common Settings**—to configure the basic settings for the Communication Server.

• **Android Settings**—to configure the notification and agent customization settings for Android mobile device management.

• **iOS Settings**—to configure the SCEP setting and upload the APNs and SSL certificates for iOS mobile device management.

---

**Note**

Android Settings and iOS Settings are only available in Full Version deployment mode.

Configuring Common Communication Server Settings

**Procedure**

1. Log on to the Mobile Security administration web console.
2. Click Administration > Communication Server Settings.
3. Click the Common Settings tab.
4. Under section Communication Server Type, select one of the following two options:
   - **Local Communication Server**—if you have already installed the Communication Server locally in your network.
   - **Cloud Communication Server**—if you want to use Communication Server deployed in the cloud.
5. Under section **Settings for Communication Between Communication Server and Mobile Devices**, configure the following:

   - **External domain name or IP address**—the domain name or IP address of the Local Communication Server.
   - **HTTP port** and **HTTPS port**—used for Local Communication Server to communicate with mobile devices.

   The default HTTP and HTTPS ports are 8080 and 4343.

   **Note**

   If you configure both of these ports, the mobile devices will use HTTPS port to communicate with the Communication Server. The mobile devices will use the HTTP port only if they are unable to communicate using the HTTPS port.

6. Under section **Settings for Communication Between Communication Server and Management Server**, configure the following:

   - **Communication Server name or IP address**—the domain name or IP address of the Local Communication Server.
   - **HTTPS Port**—used for Local Communication Server to communicate with the Management Server.

   **Note**

   If you need to customize the HTTPS port, refer to *Configuring Communication Server Ports on page B-4* for details.

7. (Full Version deployment mode only) Under section **Information Collection Frequency**, configure the following:

   - **Information collection frequency**—select the frequency when Mobile Security collects the information about the applications installed on mobile devices.
   - **Information collection frequency when mobile device is in roaming**—select the frequency when Mobile Security collects the information about the applications installed on mobile devices when the mobile device is in roaming.
Note
This setting only applies to Android and iOS mobile devices.

Mobile Security will collect the information about the applications installed on the mobile device at the time the mobile device was enrolled and then according to the frequency you have selected.

Changing the frequency will reset the timer.

8. (Full Version deployment mode only) Under section Rooted/Jailbroken Device Detection, select Selective wipe the device if it is rooted or jailbroken if you want to automatically selective wipe the rooted or jailbroken mobile devices.

9. Click Save.

What to do next
See Initial Server Setup on page 4-3 for the next configuration task.

Configuring Android Communication Server Settings

Procedure

1. Log on to the Mobile Security administration web console.
   This topic applies to Full Version deployment mode only.

2. Click Administration > Communication Server Settings.

3. Click the Android Settings tab.

4. Under section Push Notifications Settings, select Enable push notification if you want to send push notifications to Android mobile devices.
5. Under section **Agent Customization**, select **Enable agent customization** to add the server IP address and port number in the Android client application that users will download from the Mobile Security Communication Server. It will also automatically add the preset Enrollment Key to the Android client application, if the **Enable preset Enrollment Key** option is selected in Device Enrollment Settings.

This means, the server IP address, port number and preset Enrollment Key will be automatically filled in the client application and users will not need to type this information manually.

6. Under section **Password Protection for System Settings**, if you want to password protect the system settings on mobile devices, select **Enable password protection for system settings**, and then type a password in the **Password** field.

7. Click **Save**.

**What to do next**

See *Initial Server Setup on page 4-3* for the next configuration task.

**Configuring iOS Communication Server Settings**

---

### Note

If you do not enable this setting, the Android mobile device users will manually need to update the company policies on the mobile device.

---

**Procedure**

1. On the Mobile Security administration web console, go to **Administration > Communication Server Settings > iOS Settings**.

The **iOS Settings** tab appears.
2. Under **Apple Push Notification service (APNs) Settings**, configure the following:
   - **Certificate type**: Select your certificate type.
   - **Certificate**: Select APNs certificate from the drop-down list, or upload a new one.

3. Under **Simple Certificate Enrollment Protocol (SCEP) Settings**, configure the following:
   a. Select **Enable SCEP**.
   b. If enabled, you must complete the following information:
      - **SCEP user URL**:
        
        [http://SCEP_IP/certsrv/mscep](http://SCEP_IP/certsrv/mscep)
      - **SCEP admin URL**:
        
        For Windows Server 2008:
        [http://SCEP_IP/certsrv/mscep_admin](http://SCEP_IP/certsrv/mscep_admin)

      **Note**
      See *Components of Mobile Security System on page 1-5* for information on SCEP.

4. Under **Client Profile Signing Credential**, configure the following:
   - **Client Profile Signing Credential**: Select a certificate for signing credential from the drop-down list, or upload a new one.

      **Note**
      To configure the Mobile Device Agent on an iOS mobile device, Mobile Security installs an **Install Profile** on the mobile device. The **Client Profile Signing Certificate** is required to change the status of **Install Profile** to **Verified**. If you do not configure this setting, the **Install Profile** shows the status as **Not Verified**.
      Configuring this setting will display the **Install Profile** status as **Verified** on mobile devices.
5. Click Save.

What to do next

See Initial Server Setup on page 4-3 for the next configuration task.

Configuring Deployment Settings

Mobile Security enables you to integrate with other MDM solutions. Use the Deployment Settings screen to deploy Mobile Security in one of the following modes:

Procedure

1. On the Mobile Security administration web console, navigate to Administration > Deployment Settings.

2. On the Server tab, select the Mobile Security deployment mode.
   - Full Version
   - Security Scan, and then select the MDM Solution from the drop down list.
     If you select any option other than Unlisted from the MDM Solution drop down list, configure the relevant settings displayed on the screen to enable its integration with Mobile Security.

3. (Security Scan deployment mode with unlisted MDM vendor only) On the Android Agent tab, select one of the following options:
   - Download from Google Play Store - If you select this option, then users need to download and install the client app manually from Google Play Store. However, the client app on the mobile device will be updated automatically whenever it is updated on Google Play Store.
   - Download from Mobile Security Server - If you select this option, then the users will be able to download it from the URL specified in the notification email.
You can also select **Auto Enrollment** to pre-configure the client app with server IP address, port number and preset enrollment key.

4. *(Security Scan deployment mode with unlisted MDM vendor only)* On the iOS Agent tab, follow the procedure displayed on the screen to complete the configuration.

5. Click **Save**.

---

**Configuring Device Enrollment Settings**

**Procedure**

1. Log on to the Mobile Security administration web console.

2. Click **Administration > Device Enrollment Settings**.

3. Click the **Authentication** tab.

4. Under section **User Authentication**, select one of the following:
   - **Authenticate using Active Directory**—to use the user information from the Active Directory to authenticate users.
   - **Authenticate using enrollment key**—to use an enrollment key to authenticate users.

   Mobile Security will automatically generate an enrollment key and send it to users in the invitation message.

   - **Enrollment key usage limitation**—select one of the following:
     - **Use for multiple times**—select this option to allow users to use the same Enrollment Key when enrolling multiple devices.
     - **Use for one time**—select this option to prevent users from reusing the Enrollment Key. You will need to send multiple invitations to each user who needs to enroll multiple devices.
• **Enrollment key expires after**—select this setting if you want to discontinue using the automatically generated enrollment key after a certain time, and then select the time from the drop-down list.

• **Use preset Enrollment Key**—select this setting if you want to manually generate the enrollment key and then click Generate to generate the enrollment key. This enrollment key will not be sent to the user in the invitation message.

• **Enrollment Key expires on**—select this setting if you want to discontinue using the manually generated enrollment key on a certain date, and then select the date from the calendar.

---

**Note**

Authenticate using Active Directory setting is available in **Full Version** deployment mode, and **Security Scan** deployment mode with unlisted MDM vendor only.

---

5. **(Full Version** deployment mode only) Under section **Device Authentication**, select one of the following:

• **Disable this setting**—to disable device authentication for mobile devices.

• **Authenticate using IMEI or Wi-Fi MAC address**—this setting enables you to upload a list of mobile devices that you want to authenticate.

  a. Click **Export allowed device list template** to download the template and create the allowed device list.

  b. After you have created the list, click **Browse** to select and import the list of mobile devices that you created in the previous step.

  c. Click **Check Data Format** to verify the data format in the allowed devices list. After verification, Mobile Security displays all the mobile devices in the **Allowed Devices’ Status** list.

  d. Select one of the following options:

     • **Delete unauthenticated devices**—to delete the mobile devices that already exist in the **Device Management** screen but do not exist in the allowed device list that you import.
• **Display unauthenticated devices in group "Unauthenticated"**—to move all the enrolled mobile devices that already exist in the Device Management screen but do not exist in the allowed device list that you import to the group Unauthenticated.

---

**Note**

If you use Device Authentication, Mobile Security will regroup all the mobile devices according to the allowed device list that you use.

---

6. Click Save.

---

**What to do next**

See *Initial Server Setup on page 4-3* for the next configuration task.

---

**Customizing Mobile Security Terms of Use**

You can customize the **Terms of Use** for the users who would download, install and use the Mobile Device Agent.

---

**Procedure**

1. Log on to the administration web console.

2. Click **Administration > Device Enrollment Settings**.

3. On the **Terms of Use Customization** tab, click **Download Terms of Use Sample** and save the *Eula_agreement.zip* file on to your computer.

4. Extract the *Eula_agreement.zip* file content.

5. Using an HTML editor, open the *Eula_agreement.html* file, make the modifications as required and then save the file.

6. On the **Terms of Use Customization** tab of **Device Enrollment Settings** screen, click **Browse** and then select the file you modified in the previous step of this procedure, and click **Open**.

   The **Terms of Use Preview** updates to the uploaded file content.
7. Click **Save**.

---

**What to do next**

See *Initial Server Setup on page 4-3* for the next configuration task.

---

**Configuring Active Directory (AD) Settings**

---

**Note**

This topic applies to **Full Version** and **Security Scan** deployment mode with unlisted MDM vendor only.

---

Trend Micro Mobile Security 9.8 SP3 provides you the option to configure user authentication based on the Active Directory (AD). Once configured, you can also use your corporate Active Directory to add mobile devices to the device list.

If you do not want to use Active Directory for user authentication or if you do not want to add users from the Active Directory, then you do not need to configure this setting.

---

**Procedure**

1. Log on to the Mobile Security administration web console.

2. Click **Administration > Active Directory Settings**.

3. Type the host name or its IP address, its port number, your domain user name and your password.

4. Click **Save**.

---

**What to do next**

See *Initial Server Setup on page 4-3* for the next configuration task.
Configuring Management Server Settings

Procedure

1. Log on to the Mobile Security administration web console.

2. Click Administration > Management Server Settings.

3. Click the Connection tab, and specify the Management Server name or IP address and its port number. The default port number for Management Server is 443.

   Note
   
   The IP address and port number on this screen are used to access the administration web console through a web browser.

4. If the Management Server uses a proxy server to connect to Internet, specify the proxy settings in the Proxy tab:

   a. On the Proxy tab, select Use the following proxy settings for Management Server, and specify the following:

      • Proxy server name or IP address
      • Port number
      • Proxy protocol
      • Exceptions: Add the web addresses for which you want to bypass proxy settings.

   b. If the proxy server needs authentication, type the user ID and password in the Proxy Authentication section.

5. Click Save.

   You will now need to use the new IP address and port number to log on to the administration web console.
What to do next

See Initial Server Setup on page 4-3 for the next configuration task.

Configuring Exchange Server Integration Settings

**Note**

This topic applies to **Full Version** deployment mode only.

**Procedure**

1. On the Mobile Security administration web console, go to **Administration > Exchange Server Integration**.

   The Exchange Server Integration screen appears.

2. Under **Exchange Connector**, select **Enable this option to ensure only compliant mobile devices access the Exchange server.**

   Refer to Exchange Connector Statuses on page 4-18 for the different statuses of Exchange Connector displayed on the Exchange Server Integration screen.

3. Under **Exchange Access Control**, update the following as required:
   - Select **Automatically block unmanaged devices from accessing the Exchange Server.**

   **Note**

   Devices that are not registered to the Mobile Security server are called unmanaged devices. This includes devices that were recently enrolled to the Exchange Server.

   - Select **Allow access to corporate data (emails, calender, contacts, etc.) for the following devices** and then select one of the following:
     - Only healthy devices
     - Healthy and non-compliant devices
Note
See the topic Dashboard Information in the Administrator's Guide about the different mobile device registration statuses.

- Select Automatically enable the Auto Allow/Block Access option for all managed devices.

Note
Enabling this option automatically allows or blocks access to the Exchange Server depending on the status of a managed device.

- Using the drop-down list, specify the number of days after which blocked devices will be unable to access the Exchange Server.

4. Click Save.

What to do next
See Initial Server Setup on page 4-3 for the next configuration task.

For other steps of setting up Exchange Server integration, see Setting Up Exchange Server Integration on page 3-16.

Exchange Connector Statuses

Note
This topic applies to Full Version deployment mode only.

The following table lists the different Exchange Connector statuses displayed on the Exchange Server Integration screen.

**TABLE 4-2. Exchange Connector statuses**

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Exchange Connector is connected with the Management Server.</td>
</tr>
</tbody>
</table>
### Configuring Server Component

<table>
<thead>
<tr>
<th><strong>Status</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Waiting for Exchange Connector</td>
<td>The Management Server is waiting for the Exchange Connector to connect to the Management Server.</td>
</tr>
<tr>
<td>Warning</td>
<td>The Exchange Connector is not connected with the Management Server for more than five minutes.</td>
</tr>
<tr>
<td>Disconnected</td>
<td>The Exchange Connector is not connected with the Management Server for more than nine minutes.</td>
</tr>
<tr>
<td>Disabled</td>
<td>Exchange Connector is connected with the Management Server but disabled in Mobile Security Exchange Server Integration Settings.</td>
</tr>
</tbody>
</table>

### Configuring Notifications & Reports Settings

You may configure the notification source to send out the notification email messages to the administrators.

#### Procedure

1. Log on to the Mobile Security administration web console.

2. Click **Notifications & Reports > Settings**.

3. Type the **From** email address, the SMTP server IP address and its port number. If the SMTP server requires authentication, select **Authentication**, and then type the user name and password.

#### What to do next

See *Initial Server Setup on page 4-3* for the next configuration task.

For other steps in setting up Mobile Device Agent, see *Setting Up Mobile Device Agent on page 5-3*. 
Configuring Administrator Notifications

You can configure Administrator Notifications and Reports setting to receive the error message notifications and regular scheduled reports via email.

Procedure

1. Log on to the administration web console.

2. Click Notifications & Reports > Administrator Notifications & Reports.

3. Select the notifications and reports you want to receive via email, and then click on individual notifications and reports to modify their contents. Click Save when done, to return back to the Administrator Notifications and Reports screen.

   Note

   When you select reports that you want to receive, you can also adjust their frequencies individually from the drop-down list after each report.

4. Click Save.

What to do next

See Initial Server Setup on page 4-3 for the next configuration task.

Verifying Mobile Security Configuration

Mobile Security provides the Configuration and Verification screen to verify if all the settings that you have configured are correct.

Procedure

1. Log on to the administration web console.

2. Click Administration > Configuration and Verification.
3. Click **Verify Mobile Security Configuration**.

What to do next

See *Initial Server Setup on page 4-3* for the next configuration task.
Chapter 5

Handling Mobile Device Agent

This chapter provides the mobile device requirements and models that Mobile Device Agent supports, and discusses the different mobile device agent deployment methods on different platforms.

This chapter contains the following sections:

- Supported Mobile Devices and Platforms on page 5-2
- Device Storage and Memory on page 5-2
- Setting Up Mobile Device Agent on page 5-3
- Configuring Server for Invitation Messages (Optional) on page 5-4
- Configuring Installation Message on page 5-4
- Inviting a User to Register on page 5-5
- Installing MDA on Mobile Devices on page 5-9
- Enrolling MDA to the Mobile Security Management Server on page 5-15
- Upgrading MDA on Mobile Devices on page 5-21
Supported Mobile Devices and Platforms

**Note**

Make sure the mobile devices can connect to the Communication Server through Wi-Fi, 3G/GPRS, or using the Internet connection on a host computer.

Before installing and using the Mobile Security mobile device agent program (known as the Mobile Device Agent) on mobile devices, ensure that your mobile devices meet the requirements.

**Device Storage and Memory**

**Table 5-1. System Requirements**

<table>
<thead>
<tr>
<th>OPERATING SYSTEM</th>
<th>VERSION</th>
<th>MEMORY (MB)</th>
<th>STORAGE (MB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Android</td>
<td>4.0 and above</td>
<td>10</td>
<td>8</td>
</tr>
<tr>
<td>iOS</td>
<td>6.0 and above</td>
<td>4</td>
<td>3</td>
</tr>
</tbody>
</table>
# Setting Up Mobile Device Agent

## Table 5-2. Process of Setting Up Mobile Device Agent

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>(Optional) Install the SMS Sender</td>
<td>If you want to send the installation and enrollment details to the users using SMS text message and/or email, perform these steps. If you do not want to send notifications by SMS, you need to install an SMS Sender. See <em>Installing SMS Sender on page 3-16</em> for the detailed procedure.</td>
</tr>
<tr>
<td>Step 2</td>
<td>(Optional) Configure notifications settings for mobile devices.</td>
<td>See <em>Configuring Notifications &amp; Reports Settings on page 4-19</em> for the detailed procedure.</td>
</tr>
<tr>
<td>Step 3</td>
<td>(Optional) Configure the installation message that Mobile Security sends in an email and/or a text message to the users.</td>
<td>The installation message includes the URL that users can access to download and install the MDA setup package. See <em>Configuring Installation Message on page 5-4</em> for the detailed procedure.</td>
</tr>
<tr>
<td>Step 4</td>
<td><em>(Full Version deployment mode, and Security Scan deployment mode with unlisted MDM vendor only.)</em> <em>(Optional) Send invitation to users.</em></td>
<td>See <em>Inviting a User to Register on page 5-5</em> for the detailed procedure.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Install MDA on mobile devices.</td>
<td>See <em>Installing MDA on Mobile Devices on page 5-9</em> for the detailed procedure.</td>
</tr>
</tbody>
</table>
### Configuring Server for Invitation Messages (Optional)

You can set up the invitation messages to send the installation and enrollment details to the users using email messages.

You may skip this section if you do not want to use the invitation message for MDA installation and enrollment.

### Configuring Installation Message

Use the **Installation Message** screen to type the message you want to display.

This task is a step in the process for setting up Mobile Device Agent.

See *Setting Up Mobile Device Agent on page 5-3*.

#### Procedure

1. Log on to the Mobile Security administration web console.

2. Click **Notifications & Reports > User Notifications**.

3. Click the text **Mobile Device Enrollment** to open the **Mobile Device Enrollment configuration** screen.

4. Check the default subject, email and/or the text message in the related text box(es), and modify them if required.
Note
While editing the Message field, if you include the token variable `<%DOWNLOADURL%>`, it will be replaced by the actual URL that allows users to download the Mobile Device Agent setup file from the server.

Example: `<a href='%DOWNLOADURL%'><%DOWNLOADURL%></a>`

Note
The email notification only sends the download link for downloading client setup files, and will not automatically fill the server IP address and port number in the enrollment screen.

5. Click Save.
6. Click Notifications & Reports > User Notifications.
7. Select Mobile Device Enrollment and click Save.

Inviting a User to Register

Note
This topic applies to Full Version and Security Scan deployment mode with unlisted MDM vendor only.

This task is a step in the process for setting up Mobile Device Agent.

See Setting Up Mobile Device Agent on page 5-3.

Procedure
1. On the Mobile Security administration web console, go to Users.

   The Users screen displays.

2. On the Users tab, click Invite Users and then select one of the following options.
<table>
<thead>
<tr>
<th>METHOD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
</table>
| Invite users manually       | This method allows you to add user information one at a time by filling out the form.  
For more information, see Inviting a User Manually on page 5-6. |
| Invite users from CSV file  | This method allows you to copy and paste the user information from a CSV file.  
For more information, see Inviting a User from a CSV File on page 5-7. |
| Invite users from Active Directory | This method allows you to select users from the Active Directory.  
For more information, see Inviting a User from the Active Directory on page 5-8. |

**Inviting a User Manually**

You can use this option to invite users by using the form to add user information one at a time.

**Procedure**

1. On the Mobile Security administration web console, go to Users > Invite Users > Manually.

   The Invite Users Manually screen appears.

2. On the Invite Users Manually window, complete the following fields.

   - **Phone number**—type the phone number of a mobile device. To ensure that the mobile device can receive notification messages successfully from an SMS sender, you may type the country code (1-5 digits long). You do not have to type the international direct dialing prefix.
• **Email**—type the user email address to send notification mail.

• **User Name**—type the name of the user to identify the device in the device tree.

• **Group**—select the group from the drop-down list.

---

**Tip**

You can re-assign the user to a different group at a later time from the **Devices** screen.

---

3. To invite more users, click the + button and repeat step 2.

4. Click **Save**.

   A confirmation message appears.

---

## Inviting a User from a CSV File

This option allows you to copy user information from a CSV file that uses the required data format. Mobile Security automatically detects and converts the data to complete the user information form.

---

**Procedure**

1. On the Mobile Security administration web console, go to **Users > Invite Users > From CSV**.

   The **Invite Users from CSV** screen appears.

2. Type the user information using the following format in the text box.

   Phone_number1, email1, user_name1, group_name1

   **Note**

   Use a semicolon (;) or a line break to separate each user information.

3. Click **Validate** to verify that the information follows the specified format.
A pop-up message displays the validation result.

Note

If the format is incorrect, fix the errors and try again.

4. Click Save.

A confirmation message appears.

Inviting a User from the Active Directory

Note

This topic applies to Full Version and Security Scan deployment mode with unlisted MDM vendor only.

This option allows you to select users or groups from the Active Directory.

Procedure

1. On the Mobile Security administration web console, go to Users > Invite Users > From Active Directory.

The Invite Users from Active Directory screen appears.

2. Type the user information in the search field provided, and click Search.

3. Select the users or groups from the search result, and then click Invite.

The invitation list displays the selected users.

Note

If you select a group, the invitation list displays all users belonging to the group.

4. To manually add a user to the invitation list, click the add button (➕) in the Action column. To delete a user, click the delete button (➖).
5. To apply the group setting of the first user to all users, complete the following steps:
   a. Select an option from the Group drop-down list for the first user.
   b. Click Apply to All.
   c. Click OK.

6. Click Save.
   A confirmation message appears.

Installing MDA on Mobile Devices

This task is a step in the process for setting up Mobile Device Agent.
See Setting Up Mobile Device Agent on page 5-3.

This section provides details about installing Mobile Device Agent on iOS and Android mobile devices.

iOS Mobile Devices

You can install the MDA on iOS mobile devices by using one of the following methods:

• Installation Method I—Download and install the MDA directly on a mobile device from iTunes store or a specified URL. See Installation Method I on page 5-9 for the procedure.

• Installation Method II—Download and install MDA automatically without logging in to iTunes account. This deployment method is ONLY available in Full Version Deployment Mode. See Installation Method II (Full Version Only) on page 5-10 for the procedure.

Installation Method I

This method enables you to download and install the MDA directly on a mobile device from iTunes store or a specified URL.
See *iOS Mobile Devices on page 5-9* for the other method.

**Procedure**

1. Follow the installation steps for your Mobile Security iOS app version.
   
   • **Full version**
     
     a. Go to the Apple store and search for the app *Trend Micro ENT Security*.
     
     b. Tap Install.
   
   • **Security scan only**
     
     a. Go to the download URL specified in the invitation email.
     
     b. Download and install the Mobile Security iOS app.

2. Before you can start using Mobile Security, you need to perform the following steps.
   
   a. On your iOS device, go to **General > Profiles & Device Management**.
   
   b. Tap **Trend Micro Incorporate (Ent)**.
   
   c. Tap **Trust "Trend Micro Incorporate (Ent)"**.

**Installation Method II (Full Version Only)**

**Before you begin**

Make sure the following:

• You have configured your Volume Purchase Program (VPP) account. Refer to the topic *Setting Up Volume Purchase Program Licenses* in *Administrator's Guide* to configure Volume Purchase Program settings.

• There are enough VPP licenses available for your Enterprise Mobile Security application that you want to deploy for each user.

• You have configured Mobile Security for the Apple Device Enrollment Program (DEP), and make sure that the option under **Enterprise Mobile Security Agent**
License section is selected. Refer to the topic Setting Up Mobile Security for the Device Enrollment Program in Administrator’s Guide for the configuration.

This method enables you to download and install Mobile Device Agent (MDA) automatically without logging in to iTunes account.

See iOS Mobile Devices on page 5-9 for the other method.

Procedure

1. Reset your iOS mobile device to factory settings.

2. Start the iOS mobile device and deploy the Enterprise Mobile Security MDA profile through DEP.

   After the MDA profile is installed, the App Installation message appears on the screen.

3. Tap Cancel on the App Installation message.

   The Enterprise Mobile Security MDA deploys on the iOS mobile device.

4. Launch the Enterprise Mobile Security application, and accept the privacy message.

   The Enterprise Mobile Security application enrolls to the Mobile Security server automatically.

Android Mobile Devices

You can install the MDA for Android mobile devices using one of the following methods:

- Installation Method I—Download and install the MDA directly on a mobile device from Google Play store. Search for Trend Micro Enterprise Mobile Security on Google Play, and then download and install Enterprise Mobile Security application from Trend Micro.

- Installation Method II—Download and install the MDA directly on a mobile device from the Management Server. See Installation Method II on page 5-12 for the procedure.
Installation Method III—Download the MDA installation package on a computer using a web browser, then transfer it to the mobile device and install. See **Installation Method III on page 5-13** for the procedure.

Installation Method IV—Download the MDA installation package on a computer using Mobile Device Management console, then transfer it to the mobile device and install. See **Installation Method IV on page 5-14** for the procedure.

The default invitation email message sent to the users instructs the users to download and install the MDA app from Google Play store (Method I). If you want to use another method for users to install the app, modify the invitation email message sent to the users. Refer to the topic **Configuring User Notifications** in *Administrator's Guide*.

### Installation Method I

This method enables you to download and install the MDA directly on a Mobile Device from Google Play store.

See **Android Mobile Devices on page 5-11** for other methods.

**Procedure**

1. On the mobile device, open Google **Play Store**.
3. Tap **Install**, and then tap **Accept** to start the installation process.

   After the installation process completes, tap **Open** to start the application.

### Installation Method II

This method enables you to download and install the MDA directly on a Mobile Device from Mobile Security Management Server.

See **Android Mobile Devices on page 5-11** for other methods.
Procedure

1. Do one of the following:

   • If you are using Local Communication Server or the Cloud Communication Server, open the text message or email received from Mobile Security, and access the URL on the mobile device where you want to install the MDA to download the installation package.

   • If you are using Local Communication Server, access one of the following URLs using a web browser on the mobile device where you want to install the MDA to download the installation package:

     http://External_domain_name_or_IP_address:HTTP_port/mobile

     or

     https://External_domain_name_or_IP_address:HTTPS_port/mobile

   Note

   • Replace External_domain_name_or_IP_address, HTTP_port, and HTTPS_port as you configured in Administration > Communication Server Settings > Common Settings > Settings for Communication Between Communication Server and Mobile Devices.

   • If you use HTTPS to download Mobile Device Agent, you must configure a public certificate. Refer to the following URL for the details:


2. If the installation does not start automatically, launch the installation package and complete the installation.

Installation Method III

If you are using Local Communication Server, this method enables you to download the MDA installation package on a computer using a Web browser, then transfer it to the mobile device and install.
See *Android Mobile Devices on page 5-11* for other methods.

---

**Procedure**

1. On a computer, navigate to one of the following URLs to download the installation package:

   http://External_domain_name_or_IP_address:HTTP_port/mobile

   or

   https://External_domain_name_or_IP_address:HTTPS_port/mobile

   **Note**
   
   - Use the values assigned to *External_domain_name_or_IP_address*, *HTTP_port*, and *HTTPS_port*. To check the values, go to *Administration > Communication Server Settings > Common Settings > Settings for Communication Between Communication Server and Mobile Devices*.
   
   - If you use HTTPS to download the Mobile Device Agent, you must configure a public certificate. Refer to the following URL for the details:


2. Select the operating system of the mobile device to download the installation package.

3. Copy the installation package to the mobile device.

4. Launch the installation package and complete the installation.

---

**Installation Method IV**

This topic applies to **Full Version** deployment mode only.

This method enables you to download the MDA installation package on a computer using administration web console, then transfer it to the mobile device and install.

See *Android Mobile Devices on page 5-11* for other methods.
Procedure

1. Log on to the Mobile Security administration web console.
2. Click Administration > Device Enrollment Settings.
3. On the Agent Installation tab, select the agent installation package and click Download to download the ZIP file to your computer.
4. Extract the ZIP file and copy the installation package to the mobile device.
5. Launch the installation package and complete the installation.

Enrolling MDA to the Mobile Security Management Server

You will need to manually enroll the MDA to the Mobile Security if you install the MDA manually or if the automatic enrollment process fails.

This task is a step in the process for setting up Mobile Device Agent.

Android Mobile Devices

You can enroll the MDA using one of the following methods:

• Enroll using QR code.
  Use this method if you are using Local Communication Server or the Cloud Communication Server.

• Enroll using server address.
  Use this method if you are using Local Communication Server.

• Enroll without using server address.
  Use this method if you are using Cloud Communication Server.
Enrolling Using QR Code

Procedure

1. Start the Mobile Device Agent program on the mobile device.
2. Tap Enroll Using QR Code.
3. Open the invitation email on a computer or another mobile device and scan the QR code received in the invitation email using the mobile device camera.
4. If required, type the user name and password in the fields provided, and then tap OK.

   The Mobile Device Agent will be enrolled with the Mobile Security Management Server.

Enrolling Using Server Address

Procedure

1. Start the Mobile Device Agent program on the mobile device.
2. Tap Enroll Manually.
3. Tap the Local Server tab, type the server address and port number in the relevant fields and then tap Next.
4. Type the Enrollment Key or the user name and password in the relevant fields and then tap Next.

   The Mobile Device Agent will be enrolled with the Mobile Security Management Server.
Handling Mobile Device Agent

Enrolling Without Using Server Address

Procedure

1. Start the Mobile Device Agent program on the mobile device.
2. Tap Enroll Manually.
3. Tap the Cloud Server tab, type the Enrollment Key from the invitation email, and then tap Next.
   The Mobile Device Agent will be enrolled with the Mobile Security Management Server.

iOS Mobile Devices

To be able to manage iOS mobile devices from the Mobile Security Management Server, you must install a provisioning profile on the mobile devices. This provisioning profile must identify you (through your development certificate) and your device (by listing its unique device identifier).

WARNING!
The JavaScript must be enabled for Safari on iOS mobile devices for enrollment. Otherwise, the enrollment will be unsuccessful.

You can enroll the MDA using one of the following methods:

• Enroll using QR code.
  Use this method if you are using the Local Communication Server or the Cloud Communication Server.

• Enroll using server address.
  Use this method if you are using the Local Communication Server.

• Enroll without using server address.
Use this method if you are using the Cloud Communication Server.

**Enrolling Using QR Code**

**Procedure**

1. Start the Mobile Device Agent program on the mobile device.
2. Tap **Enroll Using QR Code**.
3. Open the invitation email on a computer or another mobile device and scan the QR code received in the invitation email using the mobile device camera.

   **Note**
   
   A dialog box may pop up requiring you to install Root CA configured for the Local Communication Server. If you do not see this dialog box, skip steps 4 to 6 and proceed to step 7.

4. Tap **OK**.

   The Install Profile screen for **TMMSMDM-CA** displays.

5. On the Install Profile screen, tap **Install**, and then on the Warning screen, tap Install.

6. After the profile is installed, click **Done** on the Profile Installed screen.

7. If required, type the user name and password in the fields provided, and tap **Log In**.

   The Install Profile screen for **MDM Enrollment Profile** displays.

8. On the Install Profile screen, tap **Install**, and then tap **Install Now** on the confirmation pop-up dialog box.

9. If the mobile device requires a passcode, type your passcode on the Enter Passcode screen that appears, and then tap **Done**.

   The Installing Profile screen appears.
10. Tap **Install** on the **Warning** confirmation screen.

   The profile installation process begins. After the process is completed, the **Profile Installed** screen displays.

11. Tap **Done**.

---

### Enrolling Using Server Address

**Procedure**

1. Start the Mobile Device Agent program on the mobile device.

2. Tap **Enroll Manually**.

3. On the **Local Server** tab, type the server address and port number, and then tap **Enroll**.

4. Type the Enrollment Key or the user name and password and then tap **Next**.

   A dialog box may pop up requiring you to install Root CA configured for the Local Communication Server. If you do not see this dialog box, skip steps 5 to 7 and proceed to step 8.

5. Click **OK**.

   The **Install Profile** screen for **TMMSMDM-CA** displays.

6. On the **Install Profile** screen, tap **Install**.

7. If the mobile device requires a passcode, type your passcode on the **Enter Passcode** screen that appears, and then tap **Done**.

8. On the **Warning** screen that appears, tap **Install**.

   The **Install Profile** confirmation message appears.

9. Tap **Install**.

10. After the profile is installed, tap **Done**.

   The **Install Profile** screen for **MDM Enrollment Profile** appears.
11. Tap Install.

12. If the mobile device requires a passcode, type your passcode on the Enter Passcode screen that appears, and then tap Done.

13. On the Warning screen that appears, tap Install.

   The Remote Management confirmation message appears.

14. Tap Trust.

15. After the profile is installed, tap Done.

Enrolling Without Using Server Address

Procedure

1. Start the Mobile Device Agent program on the mobile device.

2. Tap Enroll Manually.

3. On the Cloud Server tab, type the authentication code and then tap Enroll.

   The Install Profile screen for MDM Enrollment Profile displays.

4. On the Install Profile screen, tap Install, and then tap Install Now on the confirmation pop-up dialog box.

5. If the mobile device requires a passcode, type your passcode on the Enter Passcode screen that appears, and then tap Done.

   The Installing Profile screen appears.

6. Tap Install on the Warning confirmation screen.

   The profile installation process begins. After the process is completed, the Profile Installed screen displays.

7. Tap Done.
Upgrading MDA on Mobile Devices

After you have upgraded the Mobile Security Management Server, perform the following procedures to upgrade MDA on mobile devices.

Android Mobile Devices

After the Mobile Security Management Server upgrades, the server sends an upgrade notification to Android mobile devices automatically.

Procedure

1. On an Android mobile device, tap the upgrade notification received from the server.
2. Tap OK on the pop-up message to start the upgrade.

iOS Mobile Devices

When a new version is available on iTunes Store, an automatic upgrade notification is sent to iOS mobile devices.

Procedure

1. Open the App Store on an iOS mobile device.
2. Tap Updates.
3. Tap Update after the ENT Security app to start the update.
Appendix A

Network Ports Configurations

This appendix provides all the network ports configurations that you need while installing Trend Micro Mobile Security.

This appendix contains the following sections:

- Network Ports Configuration for Basic Security Model on page A-9
Network Ports Configuration for Enhanced Security Model with Cloud Communication Server

If you are using the enhanced security model (dual server installation) with Cloud Communication Server, configure the following network ports for Mobile Security components:

<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>NETWORK PORTS</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Management Server</td>
<td>Open the following ports:</td>
<td>Used for accessing the Mobile Security administration web console.</td>
</tr>
<tr>
<td></td>
<td>• HTTPS port 443 for the following:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Inbound connections to Management Server.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If you want to add external applications from Google Play.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The host name for the Google Play store is: play.google.com.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If you want to take advantage of Trend Micro's mobile application</td>
<td></td>
</tr>
<tr>
<td></td>
<td>reputation service (MARS) and see the security information of the uploaded</td>
<td></td>
</tr>
<tr>
<td></td>
<td>APK files.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The host name of the MARS server is: rest.mars.trendmicro.com</td>
<td></td>
</tr>
<tr>
<td>COMPONENT</td>
<td>NETWORK PORTS</td>
<td>DETAILS</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td>Note</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This is the default HTTPS port number. If you want to change the HTTPS port number that you want to use for Management Server, see Configuring Management Server Settings on page 4-16 for the details.</td>
<td></td>
</tr>
<tr>
<td>• HTTP port 80, for the following:</td>
<td>• License server</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The host name for the license server is: licenseupdate.trendmicro.com</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If you use Trend Micro ActiveUpdate server as the update source.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The host name of the ActiveUpdate server is mobilesecurity.activeupdate.trend micro.com.</td>
<td></td>
</tr>
<tr>
<td>Management Server</td>
<td>Open the following ports:</td>
<td>Used for accessing the Mobile Security administration web console.</td>
</tr>
<tr>
<td></td>
<td>• HTTP port 80 and HTTPS port 443 for the following:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Outbound connections to Cloud Communication Service</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If you want to add external iOS apps from Apple App Store</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The host name for the Apple App Store is: itunes.apple.com.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If you want to use category-based application control for iOS mobile devices</td>
<td></td>
</tr>
</tbody>
</table>
Add the following two Cloud Communication Service hosts in the firewall exceptions:
- ccs.trendmicro.com
- ccs01.trendmicro.com
- ccs02.trendmicro.com
- ccs03.trendmicro.com

**Simple Certificate Enrollment Protocol (SCEP) Server**

Open HTTP port 80 for Communication Server and iOS mobile devices.

**(Full Version deployment mode only.)**

Used for iOS mobile devices enrollment.

If you are not using SCEP server to manage iOS mobile devices, this port is not required.

**SQL Server**

Open the following ports:
- TCP port 1433 for Management Server
- UDP port 1434 for Management Server

**Note**

TCP port 1433 is the default port to connect to the SQL Server. However, you can also use a different TCP port for SQL server, if required.

Establishes a connection between the Management Server and the remote SQL server.
Network Ports Configuration for Enhanced Security Model with Local Communication Server

If you are using the enhanced security model (dual server installation) with Local Communication Server, configure the following network ports for Mobile Security components:

<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>NETWORK PORTS</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Management Server</td>
<td>Open the following ports:</td>
<td>Used for accessing the Mobile Security administration web console.</td>
</tr>
<tr>
<td></td>
<td>• HTTPS port 443 for the following:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Inbound connections to Management Server.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If you want to add external applications from Google Play.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The host name for the Google Play store is: play.google.com.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If you want to take advantage of Trend Micro’s mobile application</td>
<td></td>
</tr>
<tr>
<td></td>
<td>reputation service (MARS) and see the security information of the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>uploaded APK files.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The host name of the MARS server is: rest.mars.trendmicro.com</td>
<td></td>
</tr>
<tr>
<td>COMPONENT</td>
<td>NETWORK PORTS</td>
<td>DETAILS</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
<td>This is the default HTTPS port number. If you want to change the HTTPS port number that you want to use for Management Server, see Configuring Management Server Settings on page 4-16 for the details.</td>
</tr>
<tr>
<td></td>
<td>• HTTP port 80, for the following:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• License server</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The host name for the license server is: licenseupdate.trendmicro.com</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If you use Trend Micro ActiveUpdate server as the update source.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The host name of the ActiveUpdate server is mobilesecurity.activeupdate.trendmicro.com.</td>
<td></td>
</tr>
<tr>
<td>Management Server</td>
<td>Open the following ports:</td>
<td>Used for accessing the Mobile Security administration web console.</td>
</tr>
<tr>
<td></td>
<td>• HTTP port 80 and HTTPS port 443 for the following:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If you want to add external iOS apps from Apple App Store</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The host name for the Apple App Store is: itunes.apple.com.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If you want to use category-based application control for iOS mobile devices</td>
<td></td>
</tr>
<tr>
<td>Communication Server</td>
<td>Open HTTP port 8080.</td>
<td>Used for communication between mobile devices.</td>
</tr>
<tr>
<td>COMPONENT</td>
<td>NETWORK PORTS</td>
<td>DETAILS</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------</td>
<td>---------</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>This is the default HTTP port number for the dual server configuration. If you want to change the HTTP port number that you want to use for mobile devices to communicate with the Communication Server during the installation, see Configuring Common Communication Server Settings on page 4-6 for the details.</td>
<td>devices and the Communication Server.</td>
</tr>
<tr>
<td>Open HTTPS port 4343.</td>
<td></td>
<td>Used for secure communication between mobile devices and the Communication Server.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>This is the default HTTPS port number for the dual server configuration. If you want to change the HTTPS port number that you want to use for mobile devices to communicate with the Communication Server during the installation, see Configuring Common Communication Server Settings on page 4-6 for the details.</td>
<td></td>
</tr>
<tr>
<td>Open TCP port 2195 for Apple Push Notification service (APNs) server. The hostname of Apple Push Notification Service is gateway.push.apple.com.</td>
<td>Enables Apple’s APNs server to manage iOS mobile devices. If you are not using APNs server to manage iOS mobile devices, this port is not required.</td>
<td></td>
</tr>
<tr>
<td>Open the HTTPS port 4343.</td>
<td>Establishes a secure connection between the Management Server and the</td>
<td></td>
</tr>
<tr>
<td>COMPONENT</td>
<td>NETWORK PORTS</td>
<td>DETAILS</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------</td>
<td>---------</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>This is the default HTTPS port number for the dual server configuration. If you want to change the HTTPS port number that you want to use for mobile devices to communicate with the Communication Server during the installation, see <em>Configuring Common Communication Server Settings on page 4-6</em> for the details.</td>
<td>Communication Server.</td>
</tr>
<tr>
<td></td>
<td>Open the TCP port 443.</td>
<td>Establishes a connection between the Local Communication Server and the Cloud Communication Server.</td>
</tr>
</tbody>
</table>
| **Active Directory** | Open one of the following ports:  
  - TCP port 389 (Domain Controller) for Management Server  
  - TCP port 3268 (Global Category) for Management Server | Used for user authentication using Active Directory. If you are not using Active Directory to authenticate or import users, this port is not required. |
| **Simple Certificate Enrollment Protocol (SCEP) Server** | Open HTTP port 80 for Communication Server and iOS mobile devices. | Used for iOS mobile devices enrollment. If you are not using SCEP server to manage iOS mobile devices, this port is not required. |
| **SQL Server** | Open the following ports:  
  - TCP port 1433 for Management Server | Establishes a connection between the Communication Server. |
Network Ports Configuration for Basic Security Model

If you are using the basic security model (single server installation), configure the following network ports for Mobile Security components:

<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>NETWORK PORTS</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Management Server and Local Communication Server</td>
<td>Open the following ports:</td>
<td>Used for accessing the Mobile Security administration web console.</td>
</tr>
<tr>
<td></td>
<td>• HTTPS port 443 for the following:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Inbound connections to Management Server.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If you want to add external applications from Google Play.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The host name for the Google Play store is: play.google.com.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If you want to take advantage of Trend Micro’s mobile application reputation service (MARS) and see the security information of the uploaded APK files.</td>
<td></td>
</tr>
</tbody>
</table>
### Component: Management Server and Local Communication Server

<table>
<thead>
<tr>
<th>Component</th>
<th>Network Ports</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Open the following ports:</td>
</tr>
<tr>
<td></td>
<td>• HTTP port 80 and HTTPS port 443 for the following:</td>
</tr>
<tr>
<td></td>
<td>• If you want to add external iOS apps from Apple App Store</td>
</tr>
<tr>
<td></td>
<td>The host name for the Apple App Store is: itunes.apple.com.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used for accessing the Mobile Security administration web console.</td>
</tr>
</tbody>
</table>

### Network Ports Details

<table>
<thead>
<tr>
<th>Component</th>
<th>Network Ports</th>
</tr>
</thead>
<tbody>
<tr>
<td>The host name of the MARS server is: rest.mars.trendmicro.com</td>
<td></td>
</tr>
</tbody>
</table>

**Note**

This is the default HTTPS port number. If you want to change the HTTPS port number that you want to use for Management Server, see [Configuring Management Server Settings on page 4-16](#) for the details.

- HTTP port 80, for the following:
  - License server
    * The host name for the license server is: licenseupdate.trendmicro.com
  - If you use Trend Micro ActiveUpdate server as the update source.
    * The host name of the ActiveUpdate server is mobilesecurity.activeupdate.trendmicro.com.
<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>NETWORK PORTS</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Management Server and Local Communication Server</td>
<td>Open HTTP port 8080.</td>
<td>Used for communication between mobile devices and the Communication Server.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This is the default HTTP port number for the dual server configuration. If you want to change the HTTP port number that you want to use for mobile devices to communicate with the Communication Server during the installation, see Configuring Common Communication Server Settings on page 4-6 for the details.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Open HTTPS port 4343.</td>
<td>Used for secure communication between mobile devices and the Communication Server.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This is the default HTTPS port number for the dual server configuration. If you want to change the HTTPS port number that you want to use for mobile devices to communicate with the Communication Server during the installation, see Configuring Common Communication Server Settings on page 4-6 on page 4-6 for the details.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Open TCP port 2195 for Apple Push Notification service (APNs) server. The hostname of Apple Push Notification Service is gateway.push.apple.com.</td>
<td>Enables Apple’s APNs server to manage iOS mobile devices. If you are not using APNs server to manage iOS mobile devices.</td>
</tr>
<tr>
<td>COMPONENT</td>
<td>NETWORK PORTS</td>
<td>DETAILS</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Open the TCP port 443.</td>
<td>Establishes a connection between the Local Communication Server and the Cloud Communication Server.</td>
</tr>
<tr>
<td>Active Directory</td>
<td>Open one of the following ports:</td>
<td>Used for user authentication using Active Directory.</td>
</tr>
<tr>
<td></td>
<td>• TCP port 389 (Domain Controller) for Management Server</td>
<td>If you are not using Active Directory to authenticate or import users, this port is not required.</td>
</tr>
<tr>
<td></td>
<td>• TCP port 3268 (Global Category) for Management Server</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you are not using SCEP server to manage iOS mobile devices, this port is not required.</td>
</tr>
<tr>
<td>SQL Server</td>
<td>Open the following ports:</td>
<td>Establishes a connection between the Management Server and the remote SQL server.</td>
</tr>
<tr>
<td></td>
<td>• TCP port 1433 for Management Server</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• UDP port 1434 for Management Server</td>
<td></td>
</tr>
<tr>
<td>COMPONENT</td>
<td>NETWORK PORTS</td>
<td>DETAILS</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
<td>TCP port 1433 is the default port to connect to the SQL Server. However, you can also use a different TCP port for SQL server, if required.</td>
</tr>
</tbody>
</table>

Optional Configurations

This appendix provides optional configuration procedures that you can perform while installing Trend Micro Mobile Security.

This appendix contains the following sections:

• *Using Windows Authentication for SQL Server on page B-2*
• *Configuring Communication Server Ports on page B-4*
• *Setting Up SCEP on page B-5*
Using Windows Authentication for SQL Server

Trend Micro recommends using SQL Server Authentication method for SQL Server instead of Windows Authentication. However, you can also configure Windows Authentication for SQL Server.

Procedure

1. Create a user account in Active Directory server with the Mobile Security database access rights. You may skip this step if you already have a user account with the required access rights.
   a. Create a user account in Active Directory server.
   b. Start SQL Server Management Studio and connect to the Mobile Security database.
   c. Expand the Security folder from the tree on the Object Explorer.
   d. Right-click Logins and then click New Logins.
   e. Click General from the Select a page on the left, and do the following:
      i. Type the user name that you created in of this procedure in the Login name field and click Search.
      Select User or Group dialog box appears.
      ii. Type the user name with the domain name (for example: domainname \username) in the Enter the object name to select field and click Check Names.
      iii. Click OK.
   f. Select Server Roles from the Select a page on the left, and select the following roles:
      • public
      • sysadmin
g. Click **OK**.

The user account appears in the **Logins** folder on the **Object Explorer**.

2. Add Mobile Security Management Server in to the same domain as Active Directory server.

3. On the Management Server, navigate to **Start > Administrator Tools > Computer Management** and do the following.

   a. Expand the Local Users and Groups folder from the left tree, and then double-click **Groups**.

   b. Right-click **Administrators** and click **Properties**.

   c. Click **Add** button on the **General** tab, and do the following:

      i. Type the user name that you created in step 1 of this procedure in the **Login name** field and click **Search**.

      ii. Type the user name with the domain name (for example: `domainname\username`) in the **Enter the object name to select** field and click **Check Names**.

      iii. Click **OK**.

   d. Click **OK** on the **Administrator Properties** dialog box.

4. On the Management Server, go to the following location:

   C:\Program Files\Trend Micro\ Mobile Security\  
   or  
   C:\Program Files(x86)\Trend Micro \Mobile Security\)

5. Open **TmDatabase.ini** in a text editor. If the **TmDatabase.ini** file does not exist, create a file using text editor and name it **TmDatabase.ini**.

6. Add the following text into the **TmDatabase.ini** file:
ConnectionStringFormat=Provider=sqloledb;Data Source=%server%;Initial Catalog=%database%;Integrated Security=SSPI;

![TmDatabase.ini file](image)

**Figure B-1. TmDatabase.ini file**

7. On the Management Server, open Windows Services, and double-click **Mobile Security Management Module Service**.

8. On the **Log On** tab, select **This account:** and type the account name that will access the database, and its password in **Password** and **Confirm password** fields, and then click **OK**.

9. Right-click on the **Mobile Security Management Module Service** in the services list, and then click **Restart**.

10. Configure database settings on administration web console:
   a. Log on to the administration web console.
   b. Click **Administration > Database Settings**.
   c. Type the database server IP address, user name, password and the database name.
   d. Click **Save**.

---

**Configuring Communication Server Ports**

Trend Micro Mobile Security 9.8 SP3 enables to you to customize the Communication Server ports that it uses to establish the connection with the Management Server.
Optional Configurations

**Procedure**

1. On the computer where Communication Server is installed, open the `configuration.xml` file in a text editor (located in `C:\Program Files\Trend Micro\Communication Server\` or `C:\Program Files(x86)\Trend Micro\Communication Server\`).

2. Modify the values of `mdms_https_port` to your required port number.

3. Save and then close `configuration.xml` file.

4. Open Windows services, and right-click **Mobile Security Communication Service**, and then click **Restart**.

5. Log on to the administration Web console.

6. Click **Administration** > **Communication Server Settings** > **Common Settings**.

7. Under **Settings for Communication Between Communication Server and Management Server** section, change the value of **HTTPS Port** to the port number you have configured in step 2 of this procedure.

8. Click **Save**.

---

**Setting Up SCEP**

**Note**

This topic applies to **Full Version** deployment mode only.

Setting up Simple Certificate Enrollment Protocol (SCEP) provides additional security for iOS mobile devices.

See *Setting Up Environment for iOS Mobile Devices (Optional) on page 2-3.*

---

**Procedure**

1. Install Certificate Authority
For the detailed Certificate Authority installation procedure, refer to the following URL:


---

**Note**

If you do not want to use SCEP, you do not need to install the Certificate Authority.

---

2. **Configure Simple Certificate Enrollment Protocol (SCEP)**

If you have set up SCEP on Windows Server 2008, install the Network Device Enrollment Service for Windows Server. Refer to the following URL for the installation and deployment procedure of Network Device Enrollment Service:


or


---

**Note**

If you want to use SCEP, Trend Micro recommends using it on Windows Server 2008.

---

3. **Verify system clocks**

Make sure that the system clocks of SCEP server, Communication Server and the Management Server are set to the correct time.

4. **Modify Policy Module properties for Certificate Authority:**

   a. On the computer where Certificate Authority is installed, open the **Certification Authority** management console.

   b. Click **Policy Module** tab, and then click **Properties**.

   c. Select **Follow the settings in the certificate template, if applicable. Otherwise, automatically issue the certificate.**

   d. Click **OK**.
5. Apply the following set of rules:

   - iOS mobile devices should be able to connect to the Communication Server.
   - Communication Server should be able to connect to the SCEP server.
   - iOS mobile devices should be able to directly connect to the SCEP server when enrolling to the Mobile Security Management Server.

6. Verify the SCEP installation (Optional):

   For SCEP running on Windows Server 2008, access the following URL from the Communication Server:

   \[ \text{http://SCEPServerIP/certsrv/mscep_admin} \]

   **Note**
   Replace **SCEPServerIP** with the actual SCEP server IP address in the URL.

   If you see the Web page similar to the following, your server is configured correctly:

   ![Configuration Verification](image)

   **FIGURE B-2. Configuration Verification**
**Note**

When iOS mobile device enrolls, it will be able to access the following URL:

http://SCEPServerIP/certsrv/mscep

The iOS mobile device only needs to connect to the SCEP for enrollment, and does not require this connection for any further use.

---

**Configuring Local Communication Server High Availability**

Trend Micro Mobile Security enables you to configure High Availability (HA) for the Local Communication Server.

The following figure shows the required configuration for HA.
You must install the Local Communication Server on both nodes (LCS Node 1, and LCS Node 2) in the same directory.
Example for Local Communication Server High Availability Configuring

To set up High Availability (HA), Mobile Security requires configuring all the network components within the same network domain using certain IP addresses. The following figure shows the details of IP addresses and relationship between each network component.

This section assumes the IP addresses for each of the components in the network. Replace the IP addresses mentioned in the following table with the actual IP addresses in your network.

IP1, IP2, IP3, IP4: The physical IP addresses of the server
IP5: Floating IP address for Windows Cluster
IP6: Floating IP address for LCS HA Service

Note: Mobile Security Management server and Mobile devices access LCS using IP6, the floating IP address of LCS HA service
Optional Configurations

<table>
<thead>
<tr>
<th>NETWORK COMPONENT</th>
<th>IP ADDRESSES</th>
</tr>
</thead>
<tbody>
<tr>
<td>HA server IP address (IP6)</td>
<td>10.204.34.237</td>
</tr>
<tr>
<td>Local Communication Server 1 IP address (IP1)</td>
<td>10.204.34.231</td>
</tr>
<tr>
<td>Local Communication Server 2 IP address (IP2)</td>
<td>10.204.34.232</td>
</tr>
<tr>
<td>Local Communication Server HTTP port</td>
<td>8080</td>
</tr>
<tr>
<td>Local Communication Server HTTPS port</td>
<td>4343</td>
</tr>
</tbody>
</table>

**Important**

Before configuring HA, make sure that the Local Communication Server and the HA server are configured in the same network domain.

Assuming the IP addresses and port numbers in the table above, the following will be the configuration for Local Communication Server on the Mobile Security administration web console.

<table>
<thead>
<tr>
<th>Settings for Communication Between Communication Server and Mobile Devices</th>
</tr>
</thead>
<tbody>
<tr>
<td>External domain name or IP address:</td>
</tr>
<tr>
<td>[ ] HTTP port:</td>
</tr>
<tr>
<td>[ ] HTTPS port:</td>
</tr>
</tbody>
</table>

  Enable HTTPS if there will be iOS or Windows Phone devices in your group.

<table>
<thead>
<tr>
<th>Settings for Communication Between Communication Server and Management Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Server name or IP address:</td>
</tr>
<tr>
<td>HTTPS Port:</td>
</tr>
</tbody>
</table>

Refer to the topic *Configuring Common Communication Server Settings on page 4-6* for the detailed procedure for configuring the Local Communication Server.
Appendix C

Generating and Configuring APNs Certificate

Trend Micro Mobile Security requires the Apple Push Notification service (APNs) certificate to manage iOS mobile devices. This appendix introduces the detailed procedure of generating the APNs certificate and then uploading it to the Mobile Security Management Server.

For other setup requirements, see Setting Up Environment for iOS Mobile Devices (Optional) on page 2-3.

This appendix contains the following sections:

- Understanding APNs Certificate on page C-2
- Generating an APNs Certificate on page C-2
- Generating an APNs Certificate from a Windows Server on page C-4
- Generating an APNs Certificate from a Mac Workstation on page C-18
- Uploading APNs Certificate to Mobile Security Management Server on page C-23
Understanding APNs Certificate

The Apple Push Notification service (APNs) enables Trend Micro Mobile Security for Enterprise server to securely communicate to your devices over-the-air (OTA). Each organization needs its own APNs certificate to ensure a secure mechanism for their devices to communicate across Apple's push notification network.

Trend Micro Mobile Security for Enterprise uses your APNs certificate to send notifications to your devices when the Administrator requests information or manage your iOS devices. Only the notification is sent through the APNs server.

![Diagram of Notification process]

**Figure C-1. Notification process**

Generating an APNs Certificate

This section explains the process of generating Apple Push Notification Service certificate for iOS mobile devices management.

**Procedure**

1. Generate a Certificate Signing Request (CSR) from a Windows Server or a Mac Workstation.
2. Have Trend Micro or Apple sign the CSR.

- **Using certificate signed by Trend Micro**: Trend Micro provides a simple process to sign your CSR:
  
a. Go to the Trend Micro APNs Certificate Signing Portal to provide your corporate information, your product Activation Code and a copy of your CSR:

  [http://forms.trendmicro.com/download_trials/csr/?dom=us](http://forms.trendmicro.com/download_trials/csr/?dom=us)

  Once the request is submitted to the portal, an email with the signed CSR will be sent to you.

  b. Using a verified Apple ID, upload the signed CSR to Apple Push Certificates Portal.

  Apple will generate an APNs certificate.

- **Using certificate signed by Apple**: If you want to use the certificate signed by Apple, make sure that you have the following before you proceed:
  
  
  - Your developer account role assigned as an Agent (Admin role will not work)
  
  - Administrator permissions on your Windows Server or Mac OS X workstation

  To use the certificate signed by Apple, see [Using the Certificate Signed by Apple on page C-10](#) for Windows or [Using the Certificate Signed by Apple on page C-20](#) for Mac.

3. Install your APNs certificate on your Windows Server or a Mac Workstation, and then export the certificate to save it or your computer.

Once you have exported the certificate, proceed to upload this certificate to the Trend Micro Mobile Security Management Server.
Generating an APNs Certificate from a Windows Server

The following steps will guide you to generate an APNs certificate from a Windows Server. If you have already generated your certificate from a Mac OS X workstation, you can skip this section and upload your certificate to Trend Micro Mobile Security for Enterprise MDM server.

Step 1: Generating a Certificate Signing Request

Procedure

1. Navigate to Start Administrative Tools Internet Information Services (IIS) Manager, and select the server name.
2. Double-click Server Certificates icon.

![Image of Server Manager](image)

**FIGURE C-2. Accessing Server Certificates**
Note

The IIS version 7.0 is used to configure APNs certificate in this document.

3. From the Actions pane on the right, click Create Certificate Request.

   The Request Certificate wizard appears.

   ![Image of the Request Certificate wizard]

   **FIGURE C-3. Starting Request Certificate wizard**

4. In the Distinguished Name Properties window, type the following:
   - **Common name**—the name associated with your Apple Developer account
   - **Organization**—the legally registered name of your organization/company
   - **Organizational unit**—the name of your department within the organization
   - **City/locality**—the city in which your organization is located
   - **State/province**—the state or province in which your organization is located
- **Country/region**—the country or region in which your organization is located

![Request Certificate](image)

**Figure C-4. Distinguished Name Properties screen**

5. Click Next.

   **Cryptographic Service Provider Properties** window appears.

6. Select **Microsoft RSA SChannel Cryptographic Provider** in the **Cryptographic service provider** field and **2048** in the **Bit length** field, and then click **Next**.
Figure C-5. Cryptographic Service Provider Properties screen

7. Select a location where you want to save the certificate request file. Make sure to remember the filename and the location where you save the file.
Figure C-6. File Name screen

8. Click Finish.

You have now created a CSR and are ready to upload it to your Apple development portal.

\textbf{Important}

Trend Micro recommends you to save the CSR file you have just created at a secure location. You will need to use it again when you renew your APNs certificate next time. Using a different APNs certificate will require you to enroll all the iOS mobile device again to the Mobile Security Management Server. Refer to \textit{Renewing an APNs Certificate on page C-25} for details.
Step 2: Uploading CSR and Generating the APNs Certificate

After you have generated the CSR, you can now do one of the following:

- Upload the CSR to the Trend Micro CSR Signing Portal to get it signed by Trend Micro, and then use it to generate the APNs certificate.
- Upload the CSR to the Apple Development portal to get it signed by Apple, and then use it to generate the APNs certificate.

Note

The following procedure assumes that you use the APNs certificate signed by Trend Micro.

If you want to use the APNs certificate signed by Apple, skip this procedure and refer to Using the Certificate Signed by Apple on page C-10 for Windows or Using the Certificate Signed by Apple on page C-20 for Mac.

Procedure

1. On a Web browser, navigate to the following URL:

   http://forms.trendmicro.com/download_trials/csr/?dom=us

2. Fill the applicable fields and upload the CSR you have just generated, and then click Proceed.

   Trend Micro will sign and return you the signed certificate.

3. Download the signed certificate from the Trend Micro portal or from the email that you have received.

4. Upload the CSR to the Apple Push Certificates Portal:
   a. Open the Web browser and navigate to the following URL:

      https://identity.apple.com/pushcert/
   b. Sign in with your Apple ID and password.

      The Get Started page displays.
c. Click **Create a Certificate** button.

The **Terms of Use** screen appears.

d. Click **Accept** to agree with the terms.

**Create a New Push Certificate** screen displays.

e. Click **Browse**, select the file already signed by Trend Micro, and then click **Upload**. Wait until the portal generates the APNs certificate (`.pem`) file.

f. Click **Download** to save the `.pem` file to your computer.

g. Rename the `.pem` you have just downloaded to `.cer`, and then proceed to *Step 3: Installing Your APNs Certificate on page C-12* for Windows.

---

### Using the Certificate Signed by Apple

**Note**

Skip this procedure if you have already obtained the APNs certificate signed by Trend Micro.

---

**Procedure**

1. On the Web browser, navigate to the following URL:

   ```html
   https://developer.apple.com/
   ```

2. Click the **Member Center** link.

3. Sign in with your Apple ID and password.

4. Click **iOS Provisioning Portal**.

**Note**

If you do not see the iOS Provisioning Portal, your development account has not been set up for iOS development.
5. On the left pane, click App IDs, and then click New App ID.

6. Fill in the applicable fields. The Bundle Identifier (App ID Suffix) notation field can be: com.apple.mgmt.mycompany.tmms.
   - Replace mycompany with your company name.
   - Note down The Bundle Identifier (App ID Suffix) notation value. You will need this value while configuring Mobile Security Management Server.

7. Click Submit.

   The App ID that you have just added appears in the list.

8. Click Configure.

   **Tip**
   
   If you do not see or cannot click Configure, verify that you are signed in with the Agent role.

9. Select Enable for Apple Push Notification service, and then click Configure for Production Push SSL Certificate.

   If you are unable to select Enable for Apple Push Notification service, try using Safari or Firefox Web browser, and verify that you are signed in with the Agent role.

10. SSL Certificate Assistant wizard will appear, instructing you to create a Certificate Signing Request (that you have already created in Step 1: Generating a Certificate Signing Request on page C-18). Click Continue.

11. Click Choose File and upload the Certificate Signing Request file that you created in Step 1: Generating a Certificate Signing Request on page C-18. (For example, CertificateSigningRequest.certSigningRequest2).

12. Click Generate.

   When completed, the screen will appear confirming that your APNs SSL certificate has been generated.

13. Click Continue.
The Download & Install Your Apple Push Notification server SSL Certificate screen displays.

14. Click Download to save the .cer file to your computer, and then proceed to Step 3: Installing Your APNs Certificate on page C-12 for Windows.

---

Step 3: Installing Your APNs Certificate

---

Procedure

1. Navigate to Start > Administrative Tools > Internet Information Services (IIS) Manager, select the server name, and then double-click Server Certificates.

2. From the Actions pane on the right, click Complete Certificate Request.
The Complete Certificate Request wizard appears.

![Complete Certificate Request Wizard](image)

**FIGURE C-7. Complete Certificate Request**

**Note**

If you are using IIS 7.5, clicking **Complete Certificate Request** may display the following error message:

A certificate chain could not be built to a trusted root authority.

If this happens, refer to *Configuring IIS 7.5 for APNs Certificate Installation on page C-17* for the procedure to resolve this issue.

3. Select the `.cer` certificate file that you downloaded from the Apple Developer Portal, and type **Trend Micro Mobile Security for Enterprise MDM APNs** in the **Friendly name** field.
If you generated the certificate file from the Mac Workstation, you must manually change the .pem file extension to .cer.

**Figure C-8. Specify Certificate Authority Response screen**

**Tip**

The friendly name is not a part of the certificate itself, but is used by the server administrator to easily distinguish the certificate.

4. Click **OK**.

The certificate will be installed on the server.

5. Verify that your Apple Production Push Services certificate appears on the **Server Certificates** list. If you can see the certificate, follow the next steps to export the
certificate and upload it to the Trend Micro Mobile Security for Enterprise Management Server.

6. Right-click on the certificate in the **Server Certificates** list, and then click **Export**.

![Figure C-9. Exporting the certificate](image)

7. Select the location where you want to save the file, choose a password for exporting, and then click **OK**.
Figure C-10. Specifying password for the certificate

Tip

If you only have the option to save as a .cer file rather than a .pfx, then you are not correctly exporting the certificate. Make sure you have selected the correct file to export.

Note

Make sure to remember the password, or keep it in the secure place. The password will be required when uploading the certificate to Trend Micro Mobile Security for Enterprise Management Server.

After completing all these steps, you should have the following items:

- APNs certificate (.pfx format, not .cer format).
- The password that you set when exporting the certificate.

You are now ready to upload your certificate to Trend Micro Mobile Security Management Server. See Uploading APNs Certificate to Mobile Security Management Server on page C-23 for the procedure.
Configuring IIS 7.5 for APNs Certificate Installation

If you are using IIS 7.5, uploading the certificate to IIS may fail with the following message:

A certificate chain could not be built to a trusted root authority.

This can happen due to the following reasons:

- The APNs certificate is signed by the Apple Root CA instead of a public CA.
- The enhanced check for the trusted root CA by IIS 7.5.

Procedure

1. Download the **Apple Root** certificate and **Application Integration** certificate from the following URL:
   
   http://www.apple.com/certificateauthority/

2. Double-click **Apple Root** certificate, and then on the **Certificate** window, click **Install Certificate**.

3. On the welcome screen, click **Next**.

4. Select **Place all certificates in the following store** and then click **Browse**.

5. On the **Select Certificate Store** window, select **Show physical stores**, then click **Trusted Root Certification Authorities > Local Computer** and then click **OK**.

6. Click **Next** on the **Certificate Import Wizard** screen, then click **Finish**.

7. Repeat step 2 to step 5 for **Application Integration** certificate. However, in step 4, click **Intermediate Certification Authorities > Local Computer** instead of **Trusted Root Certification Authorities > Local Computer**.
Generating an APNs Certificate from a Mac Workstation

The following procedure will guide you to generate an APNs certificate using a Mac OS X workstation. For Windows Server you may skip this section, and proceed to Generating an APNs Certificate from a Windows Server on page C-4.

Step 1: Generating a Certificate Signing Request

Procedure

1. On you Mac computer, go to Applications > Utilities > Keychain Access.

2. On the left pane, select login in the Keychain section, and then select Certificates in the Category section.

3. From the top menu bar, select Keychain Access > Certificate Assistant > Request a Certificate From a Certificate Authority.

   The Certificate Assistant wizard displays.

4. Type the email address and registered Apple Developer account name in User Email Address and Common Name fields, select Saved to disk, and then click Continue.

5. Select the location where you want to save the file, and then click Save.

You have now created a CSR and are ready to upload it to your Apple development portal.

Important

Trend Micro recommends you to save the CSR file you have just created at a secure location. You will need to use it again when you renew your APNs certificate next time. Using a different APNs certificate will require you to enroll all the iOS mobile device again to the Mobile Security Management Server. Refer to Renewing an APNs Certificate on page C-25 for details.
Step 2: Uploading CSR and Generating the APNs Certificate

After you have generated the CSR, you can now do one of the following:

- Upload the CSR to the Trend Micro CSR Signing Portal to get it signed by Trend Micro, and then use it to generate the APNs certificate.
- Upload the CSR to the Apple Development portal to get it signed by Apple, and then use it to generate the APNs certificate.

**Note**

The following procedure assumes that you use the APNs certificate signed by Trend Micro.

If you want to use the APNs certificate signed by Apple, skip this procedure and refer to Using the Certificate Signed by Apple on page C-10 for Windows or Using the Certificate Signed by Apple on page C-20 for Mac.

**Procedure**

1. On a Web browser, navigate to the following URL:
   
   http://forms.trendmicro.com/download_trials/csr/?dom=us

2. Fill the applicable fields and upload the CSR you have just generated, and then click **Proceed**.

   Trend Micro will sign and return you the signed certificate.

3. Download the signed certificate from the Trend Micro portal or from the email that you have received.

4. Upload the CSR to the Apple Push Certificates Portal:
   a. Open the Web browser and navigate to the following URL:
      
      https://identity.apple.com/pushcert/
   b. Sign in with your Apple ID and password.

   The **Get Started** page displays.
c. Click **Create a Certificate** button.

The **Terms of Use** screen appears.

d. Click **Accept** to agree with the terms.

**Create a New Push Certificate** screen displays.

e. Click **Browse**, select the file already signed by Trend Micro, and then click **Upload**. Wait until the portal generates the APNs certificate (.pem) file.

f. Click **Download** to save the .pem file to your computer.

g. Rename the .pem you have just downloaded to .cer, and then proceed to **Step 3: Installing Your APNs Certificate on page C-22** for Mac.

---

**Using the Certificate Signed by Apple**

**Note**

Skip this procedure if you have already obtained the APNs certificate signed by Trend Micro.

---

**Procedure**

1. On the Web browser, navigate to the following URL:


2. Click the **Member Center** link.

3. Sign in with your Apple ID and password.

4. Click **iOS Provisioning Portal**.

**Note**

If you do not see the iOS Provisioning Portal, your development account has not been set up for iOS development.
5. On the left pane, click **App IDs**, and then click **New App ID**.

6. Fill in the applicable fields. The **Bundle Identifier (App ID Suffix) notation** field can be: `com.apple.mgmt.mycompany.tmms`.

   - Replace **mycompany** with your company name.
   - Note down **The Bundle Identifier (App ID Suffix) notation** value. You will need this value while configuring Mobile Security Management Server.

7. Click **Submit**.

   The **App ID** that you have just added appears in the list.

8. Click **Configure**.

   **Tip**

   If you do not see or cannot click **Configure**, verify that you are signed in with the Agent role.

9. Select **Enable for Apple Push Notification service**, and then click **Configure** for Production Push SSL Certificate.

   If you are unable to select **Enable for Apple Push Notification service**, try using Safari or Firefox Web browser, and verify that you are signed in with the Agent role.

10. **SSL Certificate Assistant** wizard will appear, instructing you to create a Certificate Signing Request (that you have already created in *Step 1: Generating a Certificate Signing Request on page C-18*). Click **Continue**.

11. Click **Choose File** and upload the Certificate Signing Request file that you created in *Step 1: Generating a Certificate Signing Request on page C-18*. (For example, CertificateSigningRequest.certSigningRequest2).

12. Click **Generate**.

    When completed, the screen will appear confirming that your APNs SSL certificate has been generated.

13. Click **Continue**.
The Download & Install Your Apple Push Notification server SSL Certificate screen displays.

14. Click Download to save the .cer file to your computer, and then proceed to Step 3: Installing Your APNs Certificate on page C-22 for Mac.

**Note**
To install the APNs certificate on Windows computer, you must manually change the file extension from .pem to .cer.

### Step 3: Installing Your APNs Certificate

**Procedure**

1. Go to the location where you downloaded the file, and then double-click the file to automatically upload it to Keychain Access and complete the signing request.

2. Navigate to Applications > Utilities > Keychain Access.

3. On the left pane, select login in the Keychain section, and then select Certificates in the Category section.

4. Verify that your Apple Production Push Services certificate appears on the list, and it has an associate private key beneath it when you expand it. If you can see the certificate, follow the next steps to export the certificate and upload it to the Mobile Security Management Server.

**Note**
 If you do not see your APNs certificate or the private key is not showing, verify you have the login keychain selected, the Certificates category selected and your certificate key has been expanded. If you still do not see your certificate, repeat all of the steps above.

5. Right-click (or hold down the Ctrl key and click) the private key and click Export.

6. Choose the file name and location where you want to save the file, and then select Personal Information Exchange (.p12) file format.
Tip
If you only have the option to save as a .cer file rather than a .p12, then you are not correctly exporting the certificate. Make sure you selected the private key to export in the last step, and your file format is Personal Information Exchange (.p12).

7. Click Save.

8. Choose a password for exporting, and then click OK.

Tip
Make sure to remember the password, or keep it in the secure place. The password will be required when uploading the certificate to Trend Micro Mobile Security for Enterprise Management Server.

After completing all these steps, you should have the following items:

• APNs certificate (.p12 format, not .cer format).
• The password that you set when exporting the certificate.

You are now ready to upload your certificate to Trend Micro Mobile Security Management Server. See Uploading APNs Certificate to Mobile Security Management Server on page C-23 for the procedure.

Uploading APNs Certificate to Mobile Security Management Server

This section explains the process of uploading Apple Push Notification service (APNs) certificate to Trend Micro Mobile Security for Enterprise server to start managing iOS devices.
Note
Make sure that you have the following before you begin:

- APNs certificate file (the .pfx or .p12 format, not the .cer format)
- The password that you had set when exporting the certificate
- The administrator account of Trend Micro Mobile Security for Enterprise MDM server

Procedure
1. Log on to the administration web console.
2. Do one of the following:
   - Click Administration > Certificate Management, click Add, select the Apple Push Notification Server certificate from the hard disk, and then click Save.

   ![Add certificate](image)

   **FIGURE C-11. Add certificate through Certificate Management**
• Click **Administration > Communication Server Settings**, click **iOS Settings** tab, and then select the Apple Push Notification Server certificate from the hard disk in the **Certificate** field, and then click **Save**.

![Communication Server Settings](image)

**FIGURE C-12. Add certificate through Communication Server settings**

After completing these steps, you can now manage your iOS mobile devices.

**Renewing an APNs Certificate**

You need to renew your APNs certificate before it is expired to continue managing iOS mobile devices.
To renew an APNS certificate, perform the same steps you would if you were creating a new certificate. Then, visit the Apple Push Certificates Portal and upload the new certificate.

After logging on, you see your existing certificate or you may see a certificate that was imported from your previous Apple Developer's account. On the Certificates Portal, the only difference when renewing the certificate is that you click Renew.

Note
You must have a developer account with the Certificates Portal in order to access the site.
Index

Symbols
.apk file, 3-4

A
activation code format, 3-11
Active Directory
  Service Account, 2-8
  settings, 4-15
administration web console, 3-10
  URL, 3-9
  username and password, 3-10
Android settings
  push notifications, 4-8
APNs certificate
  about, C-2
  Apple Push Certificates Portal, C-3
  Certificate Signing Portal, C-3
  Certificate Signing Request, C-2
  hostname, A-7, A-11
Apple development portal, C-8, C-18
Apple Push Notification Service
  hostname, 2-6
Apple store, 5-10

C
common settings
  Communication Server type, 4-6
  information collection frequency, 4-7
Communication Server Connection Settings, 3-13, 3-14
Communication Server settings, 4-6
  Android settings, 4-6
  common settings, 4-6
  iOS settings, 4-6
Compatibility View, 3-10
component updates
  about, 3-22, 3-23
  download sources, 3-25
  local AU server, 3-26
  scheduled, 3-24
configuration.xml file, B-5

D
distinguished name properties, C-5

E
enrollment settings
  authentication, 4-12
  enrollment key, 4-12
Enterprise MDM server, C-15
environment
  installation, 2-2
  iOS mobile devices, 2-3
error message, C-13
Eula_agreement.zip file, 4-14
Exchange Connector
  statuses, 4-18
Exchange Server
  ExchangeConnector.zip file, 3-20
  Management Tools, 3-17, 3-20
  supported versions, 3-16

F
friendly name, C-14

I
invitation message, 5-4
iOS settings
  APNs certificate, 4-10
  SCEP settings, 4-10
L
LCS installation
  creating certificate, 3-14
  importing certificate, 3-14
  SSL certificate, 3-14

M
Management Server
  default port number, 4-16
  installation program, 3-4
MDA enrollment
  Android, 5-15
  iOS, 5-17
MDA installation methods, 5-9, 5-11
Microsoft Exchange Server Management Tools, 2-9
Mobile Security
  Active Directory, 1-7
  architecture, 1-2
  Basic Security Model, 1-2, 1-5
  certificate
    APNs certificate, 1-8
    authority, 1-7
    public and private keys, 1-7
    SCEP, 1-8
    security credentials, 1-7
    SSL certificate, 1-8
Cloud Communication Server, 1-6
  communication methods, 1-2
Communication Server, 1-6
  Communication Server types, 1-6
  components, 1-5
  deployment models, 1-2
Enhanced Security Model
  Cloud Communication Server, 1-2,
  1-3

Local Communication Server, 1-2,
  1-4
Exchange Connector, 1-7
Local Communication Server, 1-6
Management Server, 1-6
Microsoft SQL Server, 1-7
Mobile Device Agent, 1-7
SMS Sender, 1-6
SMTP server, 1-9
system requirements, 1-9
  IIS, 1-11
  Management Server and
  Communication Server, 1-10
  Microsoft Exchange Server, 1-11
  Mobile Security Exchange
  Connector, 1-12
  SMS Sender, 1-11
  SQL Server, 1-12
  web browser, 1-11
  updated information, v

N
network access rules, 2-10
notifications and reports
token variable, 5-5

O
OpenJDK, 3-4

P
password
  administration web console, 3-10
  password for certificate, C-15, C-23
port configuration
  Basic Security Model
    Active Directory, A-12
    Local Communication Server,
    A-9–A-11
Management Server, A-9–A-11
SCEP Server, A-12
SQL Server, A-12
Cloud Communication Server
 Management Server, A-2, A-3
SCEP Server, A-4
SQL Server, A-4
Local Communication Server
Active Directory, A-8
Communication Server, A-6
Management Server, A-5, A-6
SCEP Server, A-8
SQL Server, A-8
Product License screen, 3-11

R
remote lock, 3-16
remote wipe, 3-16

S
SCEP
 Certificate Authority, B-5
 Network Device Enrollment Service,
 B-6
SMS message, 3-15
SMS sender, 3-15
 setup file, 3-16
SQL Server
 Authentication method, 2-8

T
TmDatabase.ini, B-3